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1. General Information

1.1. What is CAPO

CAPO (Captools-based Automatic Parallelizer using OpenMP) automates the insertion of compiler

directives to facilitate parallel processing on shared memory parallel (SMP) machines. While CAPO is
currently integrated seamlessly into CAPTools (developed at the University of Greenwich), CAPO is

independently developed at NASA Ames Research Center as one of the components for Legacy Code

Modernization (LCM) project. Utilizing the data dependence information produced by CAlrl'ools,

CAPO produces either OpenMP or SGI multiprocessing directives for sequential FORTRAN programs
with nominal user interaction. Due to the broad support of the OpenMP standard, the generated

OpenMP codes can potentially run on a wide range of SMP machines. Generation of a mixed message-

passing (e.g. MPI) and OpenMP code is possible because of the integration of CAPO and CAPTools.

The success of CAPO relies on accurate interprocedual data dependence information which is provided
by CAPTools. CAPO generates compiler directives in three stages:

1) identification of parallel loops in the outer-most level,

2) construction and optimization of parallel regions around parallel loops, and

3) insertion of directives with a proper list of private, reduction, and shared variables.

Attempts have also been made to identify potential pipeline parallelism (implemented with point-to-
point synchronization). Although the user is still expected to inspect the generated code before actual

execution, the task has been simplified tremendously by the automation process and the built-in

graphic user interface, known as the Directives Browser. The Directives Browser provides tools for user
to interact with the parallelization process. It presents information in such a way that the user can easily

isolate problematic code sections from the rest of the code and find a solution quickly.

1.2. Distribution and Contact Information

CAPO is currently integrated in CAIffools and distributed directly from NASA Ames Research Center.
It is released in a similar way as the standard CAPTools distribution. The distributed executable of

CAPO includes all the functionality of CAPTools for generating message-passing programs as well as

the capability of producing OpenMP codes. So the user needs only to maintain one copy that is

distributed with CAPO to access the functionality of both CAPTooIs and CAPO.

To require a copy of CAPO, send a request to capo@nas.nasa.gov. You will need a license to run
CAPTools/CAPO. A test license may be obtained from the CAPTools web site (see below) or by

sending email to captools@gre.ac.uk. For NASA users, please contact capo@nas.nasa.gov directly.

For any feedback and bug report on CAPO, please send to:

CAPO Development Team at capo'_Tas nasa._,ov

For any feedback and user support on CAI'U'ools, please contact:

ca/'tools-sur_l_ort_.,:r,'ac uk or check the web site at httF,/,/_at't_,qs.','re.m uk/.

For more information on the LCM project, check:

http://www, has. nasa. _ovd.lroupsfF(_ds/Project sfl C M.
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USING CAPO: GENERAL INFORMATION

1.3. Installation and Execution

Once the user has obtained a copy of CAPO in a compressed tar file, extract files by

% gunzip -c capo-sgi-l.l.tar.gz I tar xvf -

The CAP(9 distribution is maintained in a similar directory structure as the CAPTools distribution does.

For example the executable of CAPO is in

captool/bin/{machine } /capo

where {machine } is sgi for SGI machine running IRIX, sun for SUN workstation running Solaris, and

linux_x86 for Intel machine running Linux.

The user should follow the same installation procedure to CAVrools to set up CAPO. For the

installation and use of CAPTools, please refer to the web site at http://captools.gre.ac.uk/. In summary, the

user needs to set up the following environment variables:

CA2HOME - home directory for the CAFrools/CAPO installation

OPEI,r_II_OME - home directory for the XVIEW library

CAPLIBHOME - home directory for CAPLib (not necessary for OpenMP codes).

and add "$CAPHOME/bin/{machine}" to the searching path, e.g. in csh:

setenv CAPHOME /usr/local/captool

setenv OPENWINHOME $CAPHOME/openwin

set path = ($CAPHOME/bin/sgi Spath)

CAPO is then ready for use.

1.4. How to Use This Manual

The manual is organized into three parts around the use of CAPO:

1) Using CAPO - discusses the fundamentals of using CAPO to parallelize codes,

2) Appendix - lists detailed references of parameters and the graphic user interface, and

3) Tutorials - gives more hands-on experiences.

For major changes in different versions of CAPO, see Wha tsNew included in the CAPO distribution.

Convention generally followed in this manual:

Italic address (including email), URL, remarks, emphasis

Courier code list, syntax description, program outputs

Bold window name, menu name, list name

Bold italic summary head, menu item

button, setting selection

Throughout this document, we refer CAPO to OpenMP generation and the relevant components and
CAPTools to the rest, but sometimes these two terms are used interchangeably for shared components.
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2. Computer-Aided Parallelization Process

The shared memory and distributed memory programming paradigms are two of the most popular
models used to transform existing serial codes to a parallel form. For a distributed memory

parallelization it is necessary to consider the whole program when using an SPMD paradigm. Data

placement is an essential consideration to efficiently use the available distributed memory, while the

placement of explicit communication calls requires careful consideration. Nowadays, scalability and

high performance are mostly involving hand-written parallel programs using message-passing libraries
(e.g. MPI). However, this process is very difficult.

The parallelization on a shared memory system is only relatively easier because of the globally

addressable space. The data placement appears to be less crucial than for a distributed memory

paraUelization. Historically, the lack of a programming standard for using directives and the rather

limited performance due to scalability have affected the take-up of the shared memory programming
model approach. Significant progress has been made in hardware and software technologies, as a result

the performance of parallel programs with compiler directives has also made improvements. The
introduction of an industrial standard for shared-memory programming with directives, OpenMP [8],

has also addressed the issue of portability.

In general the parallelization process in any case is error-prone, time-consuming and requires a detailed

level of expertise. Programming with directives may not necessarily produce a result that enhances

performance. In the worst case, the inserted directives can create erroneous results when used

incorrectly. While vendors may have provided tools to perform error-checking and profiling,
automation in directive insertion is very limited and often failed on large programs, primarily due to
the lack of a thorough enough data dependence analysis. Presence of these deficiencies motivated the

development of the parallelization tool CAPO. The tool automatically inserts OpenMP directives in
Fortran programs and applies a degree of optimization with nominal user interaction. CAPO is aimed

at taking advantage of the detailed interprocedural data dependence analysis provided by Computer-

Aided Parallelization Tools (CAPTools) [3], developed by the University of Greenwich, to reduce
potential errors made by users and, with nominal help from user, achieve performance close to that

obtained when directives are inserted by hand. Our approach is differed from other tools and compilers

in two respects: 1) emphasizing the quality of dependence analysis and relaxing much of the time

constraint on the analysis; 2) performing directive insertion and preserving the original code structure
for maintainability. Translation of OpenMP codes to executables is left to proper OpenMP compilers.

In this section, we outline the OpenMP programming model, give an overview of CAPTools, and then

its extension, CAPO, for generating OpenMP programs.

2.1. The OpenMP Programming Model

OpenMP [8] was designed to facilitate portable implementation of shared memory parallel programs. It
includes a set of compiler directives and callable runtime library routines that extend Fortran, C and

C++ to support shared memory parallelism. It promises an incremental path for parallelizing
sequential software, as well as targeting at scalability and performance for any complete rewrites or

new construction of applications.

OpenMP follows the fork-and-join execution model. A fork-and-join program initializes as a single

lightweight process, called the master thread. The master thread executes sequentially until the first

parallel construct (OMP PARALLEL) is encoLmtered. At that point, the master thread creates a team of

threads, including itself as a member of the team, to concurrently execute the statements in the parallel

construct. When a work-sharing construct such as a parallel do (Or,Iv Ix3) is encountered, the workload

is distributed among the members of the team. An implied synchronization occurs at the end of the DO
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USING CAPO: COMPUTER-AIDED PARALLELIZATION PROCESS

loop unless a "NOWAIT" is specified. Data sharing of variables is specified at the start of parallel or

work-sharing constructs using the SHARED and PRIVATE clauses. In addition, reduction operations

(such as stu'nmation) can be specified bv the REDUCTION clause. Upon completion of the parallel
construct, the threads in the team synchronize and only the master thread continues execution. The

fork-and-join process can be repeated many times in the course of program execution.

Beyond the inclusion of parallel constructs to distribute work to multiple threads, OpenMP introduces a

powerful concept of orphan directives that greatly simplifies the task of implementing coarse grain

parallel algorithms. Orphan directives are directives outside the lexical extent of a parallel region. This

allows the user to specify control or synchronization from anywhere inside the parallel region, not just

from the lexically contained region.

2.2. CAPTools

The Computer-Aided Parallelization Tools (CAPTools) [3] is a software toolkit that was designed to
automate the generation of message-passing parallel code. CAPTools accepts FORTRAN-77 serial code

as input, performs extensive dependence analysis, and uses domain decomposition to exploit

parallelism. The tool employs sophisticated algorithms to calculate execution control masks and

minimize communication. The generated parallel codes contain portable interface to message passing
standards, such as MPI and PVM, through a low-overhead library (CAPLib).

There are two important strengths that make CAPTools stands out. Firstly, an extensive set of
extensions to the conventional dependence analysis techniques has allowed CAPTools to obtain much

more accurate dependence information and, thus, produce more efficient parallel code. Secondly, the

tool contains a set of browsers that allow user to inspect and assist parallelization at different stages.

2.3. Generating OpenMP Directives

The goal of developing computer-aided tools to help parallelize applications is to let the tools do as

much as possible and minimize the amount of tedious and error-prone work performed by the user.
The key to automatic detection of parallelism in a program and, thus parallelization is to obtain accurate

data dependences in the program. Generating OpenMP directives is simplified somehow because we
are now working in a globally addressed space without explicitly concerning data distribution.
However, we still have to realize that there are always cases in which certain conditions could prevent

tools from detecting possible parallelization, thus, an interactive user environment is also important.

The design of the CAPTools-based automatic parallelizer with OpenMP, CAPO, had kept the above

tactics in mind. CAPO uses the data dependence analysis engine in CAl'Tools, exploits loop level

parallelism in a program, and inserts OpenMP directives automatically. The schematic structure of

CAP(9 is illustrated in Figure 1. CAPO takes a serial code as input and first performs the data

dependence analysis. User knowledge on certain input parameters in the source code may be entered to
assist this analysis for more accurate results. The process of generating OpenMP directives is

summarized in the following three stages.

1) Identify parallel loops and parallel regions. The loop-level analysis is carried out to classify loops as

parallel (including reduction), serial or potential pipeline based on the data dependence information.
Parallel loops to be distributed with work-sharing directives for parallel execution are identified by

traversing the call graph of the program from top to down. Only outer-most parallel loops are

considered, partly due to the very limited support of multi-level parallelization in available OpemMP
compilers: Parallel regions are then formed arotmd the distributed parallel loops. Attempt is also made

to identify and create parallel pipelines.
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USING CAPO: COMPUTER-AIDED PARALLELIZATION PROCESS

2) Optimize loops and regions. This stage is mainly for reducing overhead caused bv fork-and-join
and synchronization. A parallel region is first expanded as far as possible and may include calls to

subroutines that contain additional (orphaned) parallel loops. Regions are then merged together if there

is no violation of data usage in doing so. Region expansion is currently limited to within a subroutine.

Synchronization optimization between loops in a parallel region is performed by checking if the loops
can be executed asynchronously.

3) Transform codes and insert
directives. Variables in con'unon

blocks are analyzed for their

usage in all parallel regions in
order to identify threadprivate

common blocks. If a private
variable is used in a non-

threadprivate common block, the

variable is treated with a special
code transformation. A routine

needs to be duplicated if its usage

conflicts at different calling
points.

By traversing the call graph

one more time OpenMP directives

are lastly added for parallel
regions and parallel loops with

variables properly listed. The
variable usage analysis is
performed at several points to

identify how variables are used
(e.g. private, shared, reduction,

etc.) in a loop or region. Such

analysis is required for the

identification of loop types, the

construction of parallel regions,
the treatment of private variables
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Figure 1: Schematic flow chart of the CAPO architecture.

in common blocks, and the insertion of directives.

Intermediate results can be stored into or retrieved from a database. User assistance to the

parallelization process is possible through browsers implemented in CAPO (Directives Browser) and in
CAPTools. The Directives Browser is designed to provide more interactive information from the

parallelization process, such as reasons why loops are parallel or serial, distributed or not distributed.

User can concentrate on areas where potential improvements could be made, for example, by removing
false data dependences. It is part of the iterative process of parallelization.

CAPO User Manual 6



3. Producing Parallel Code with CAPO

This section describes the usual steps a user will take to produce parallel code with CAPO. The

procedure follows the outline given in Figure 1. One can refer to the Tutorials and Appendix for more

information. It is also important to keep in mind that in order to get an efficiency parallel code user

interaction with tools is almost always needed. The optimization process with CAPO Directive Browser

is given in Section 4.

3.1. Prepare Serial FORTRAN Codes

CAPO currently works on FORTRAN 77 codes. A user can

either create a single file that contains all the subroutines or

provide a . list file that lists all the FORTRAN files in the

program. Figure 2 shows an example of an "All. list" file.

The source directory structure is preserved. The file names

can be used later in the code generation.

Any unresolved symbols can be provided with dummy

routines. For example, if the FORTRAN program calls C

subroutines, dummy FORTRAN routines could be supplied

to emulate the C functions even through these dummy

routines may be deleted later on from the generated parallel

code. This was a requirement of CAPTools prior to Version

2.1. The latest CAPTools provides interfaces to the dummy

routines automatically.

CAPTools does not accept source codes that contain pre-

processing directives. It is necessary to preprocess these files

before used in CAI_ools. Although the tool tries to preserve

the original source form, these preprocessing directives will
be lost.

3.2. Make Dependence Analysis

lu.f

blts.f

buts.f

domain.f

erhs.f

error.f

exact.f

jacld.f

jacu.f

12norm.f

pintgr.f

read_input.f
rhs.f

setbv.f

setcoeff.f

setiv.f

ssor.f

verify.f

../common/print results.f

../common/timers.f

../common/wtime.f

Figure 2: An example of "All.list'.

Data dependence analysis is performed on the whole program, which is one of the key steps for

directives generation. After source files are loaded into CAPTools, user knowledge, for instance the

range of variables from the READ statements, may be entered. User supplied information can help

obtain more accurate data dependences and, thus, more efficient parallel code. An example is illustrated

in the following code:

read(*,*) isize

do I0 j=l,jm

do I0 i=l,im

ix = i ÷ (j-I

A(ix) = A(ix)

i0 continue

*isize

+ B(i,j)

The value of the parameter 1size affects the loop parallelization. For the j loop, if isize > 0, no loop-

carried data dependence exists for variable A; if i s i ze = 0, there are loop-carried data dependences for

variable A. The ambiguity in the i s ± ze value will prevent the j loop from being parallelized, i.e. a data

dependence on variable A will be assumed. User could supply the "i size > 0" information to improve

the analysis accuracy.
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USING CAPO: PRODUCING PARALLEL CODE

Depending on the program size and the thoroughness of the analysis specified, the dependence analysis
process can take minutes, hours or days to complete. Once the analysis is finished, the user should save

the result to a database before proceeding further. The dependence analysis is the most CPU intensive

part of the parallelization process. Table I lists CPU time spent on analyzing the NPB BT benchmark on

several machines. The analysis uses a single CPU. As one can see, the analysis time is roughly
proportional to the clock speed of a processor.

Table 1: CPU time spent by CAPTools on analyzing the NPB BT benchmark on several machines.

Machine Type OS Type CPU Time

Intel PIII, 500MHz
Linux 10.5 mins

512MB RAM, 512KB Cache

Intel PII, 300MHz
Linux 16.4 mins

512MB RAM, 512KB Cache

Sun UltraSparclI, 360 MHz
Solaris 15.0 rains

1GB RAM, 16KB L1, 4MB L2

Stm UltraSpardl, 300 MHz
Solaris 17.6 rains

2GB RAM, 16KB L1, 4MB L2

SGI R5K, 150 MHz
IRIX 71.4 rains

128MB RAM, 32KB L1

SGI R10K, 195MHz
IRIX 26.4 rains

512MB RAM, 32KB L1, 1MB L2

SGI R12K, 300MHz
IRIX 17.8 rains

1GB RAM, 32KB L1, 2MB L2

3.3. Inspect Loops and Optimize Directive Generation

The parallelization strategy in CAPO is loop-based. Thus, an important next step is to inspect loops

after the dependence analysis is performed, which may involve inspecting the dependences produced

by CAP'Fools. Quite often a dependence causing a loop to be serialized is due to insufficient knowledge
of value limits for some variables, as indicated in the previous section. The user can use the
dependence browser (DepGraph) to remove unnecessary dependences. However, the information in
the DepGraph window could be overwhelming.

A better approach for inspecting the loops is to use the Directives Browser implemented in CAPO (see

Section 4 for details). The browser can be activated from the View--_Directives menu and is designed
to display information that are directly related to directives insertion and are gathered from the
directives analysis. For instance, the browser provides more interactive information on the reasons for

loops to be parallel or serial and the relevant variables. The user can concentrate on loops that are
indicated as serial and optimize the dependence graph if needed. It is also possible to enforce a user-

defined loop type. After changes are made, the directive analysis is reapplied to take into account these
changes. This is an iterative process (see Figure 1). It is always a good idea to save the result to a

database whenever a change is made before directives are actually inserted.

One should keep in mind that CAPO/CArrIoots parallelization relies on the static analysis of the serial

code. The dynamic information cannot be detected and applied by the tool. Thus, in most cases user-

guided parallelization process is the only way to achieve a good quality parallel code. TOols offer
resources to simplify this process.
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USING CAPO: PRODUCING PARALLEL CODE

3.4. Generate Parallel Code with Directives

Once the dependence analysis is completed and the loop information is inspected, directives can

automatically be inserted by selecting the "Save OpenMP Directive Code" option under the File menu.

The type of directives is controlled by the CAPO parameters (as described in Appendix 1), which are
also selectable from the Setting box in the Directives Browser. One can elect to use the default setup,

which is to produce OpenMP directives with a full range of analysis. Steps in the generation of

directives are logged to a log file, by default to "code-output.log". Contents of the log file are

described in Appendix 2.

3.5. Inspect the Generated Codes and the Log Information

It is very important to inspect the generated

parallel code, together with the log
information in the log file. In particular, one

should look into any shared variables, private
variables and I/O statements that are

potenna!_.y incorrectly listed. Warnings in the
last section (PASS 3) of the log file can

indicate places where potential problems

might exist. Of course, one can use other
tools (such as ASSURE from Kuck &

Associate) to check for problems in the

parallel code.

Sometimes it is useful to find out what have

been changed at different stages of code

[ parser

analyzer

parallelizer

Figure 3: Compare source codes at different stages.

parallelization. In the framework of CAPO,
one can compare codes created at three stages as shown in Figure 3: parsing, analyzing and

parallelizing. The codes can be compared with for example the Unix 'diff' command. Comparison of
verl.f and ver2.f will review code sections that were deemed to be redundant and were removed by the

CAPTools' dependence analysis process. Comparison of ver2.f and ver3.f will review the change from

parallelization, such as directives inserted and code transformation.

3.6. Compile and Run the Parallel Code

Once the parallel code is generated, use an OpenMP compiler to compile the code. Typically a compiler

option is required to enable the directives. For example on the SGI Origird000, the "-nap" option is

needed for the SGI MIPSpro compiler to compile OpenMP codes

% f77 -o a.out -mp -O parallelcode.f

To run the code with 8 CPUs, do

% setenv OMP_NUM_THREADS 8

% ./a.out
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4. Interacting with the Directives Browser

As mentioned before although the dependence analysis carried out is very detailed, it can often contain

dependencies that had to be assumed to exist. In these cases, user assistance can be used to improve the

quality of the generated OpenMP code. This is done by classifying the different types of loops that
generally exist in application codes and using the Directives Browser to inspect and interrogate all the

loops in turn. The Directives Browser is activated from the View menu of CAPO after CAPO finishes

the directive analysis (see Figure 4 for the main window of the browser). The browser displays loops

according to their types and provides more interactive information on the reasons why loops are

parallel or serial. The user can concentrate on loops that are indicated as serial (fully or covered, as

given below). The user can also enforce the classification of a selected loop by re-defining the loop type
or define the granularity threshold for a loop so that any loop below this level is not considered for

parallelization. Another feature of the browser is to provide the access for the user to manipulate the

dependence graph (in conjunction with the DepGraph Browser) and improve the parallelization

efficiency.

Scope:

NI Routines

Loop Filter:. Sub:

I Totally Serial JAIl-_, ......

Covered Serial

Falsely Serial

True Recursion

I/0 or Exit

Reductions No Granularity

Pipeline User Defined

Chosen

Not C hose n
More FIl_r... )

Show hu'allel I/O: _

Current Routine: b).t_

26 Itnutines:

;

a - le c_.

6:',.,
E

RoutineOup... )

4 Totally" serial loops (l_. not within or containing parallel loops):
J

15 qs4_

b_te:l/l]-3_: do n-l,z_p,l t
_or: 12/2/231: do 1-L_. lend, 1

a_o_:t3/_/253: do L-Letui, l._t,-1

. Upd_ OIr_ctlves..,J Se_lng.._._.___)

Usor Loop: _

25 DOUBLE PRECISION v(5. ldJxx/2-2.1, 1day/2*2°1, .), tv(5, ldaxt2.2*l, lay), ldz (5, 5, 1c1_/2.2.1, idly), Ldy (5.5. ld_u_/2-2
• 1, ldsy), ld_ (S. 5, ida,/2*2,1, ld_y), d(5, 5, ida_/2-2°1, lday)
26 ¢ .....................................................................
27 c local varzables
28 ¢ .....................................................................

29 integer i, 3, k, _, n

30 : DOUI_LE PRECISION t_p. trap1

31 :c DOL__r PR£CISION t_ar.(5. S)

33 c For all points on a hyper-pleme (13
34 :c .....................................................................

Figure 4: The Directives Broswer main window.
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USING CAPO: INTERACTING WITH THE DIRECTIVES BROWSER

4.1. Loop Classification

The loops are identified in the browser for the following types:

i. Totally serial loops - These loops contain a loop-carried true data dependence that causes the

serialization of the loop i.e. data assigned in an iteration of the loop is used in a later iteration.

(Other possible reasons for a loop to be defined as serial include the presence of I/O or loop

exiting statements within the loop body). In addition, this loop type does not contain any nested

parallel loops and also is not contained within a parallel loop. The directive browser shows a list
of the variables and a textual explanation of why the loop is serial. However, the data dependence

may have been assumed to exist and the user may be able to supplement the dependence analyzer

with additional information to prove that the data dependence does not exist. Alternatively, the

user may wish to enforce the removal of a serializing data dependence using the dependence
browser.

ii. Covered serial loops - These are also serial loops containing a loop-carried true data dependence, so

they can be treated in a similar way to totally serial loops. However, this type of serial loop is
either nested within a parallel loop or contains parallel loops wRhin it. In the latter case, i._ the

serial loop can be made parallel (see totally serial loops) then the parallelism can be defined at a

higher level and may therefore enhance the performance of the execution.

iii. Falsely serial loops - These loops are not serial due to a loop-carried true dependence. Instead, they
will need to execute in serial due to the existence of pseudo dependencies that represent memory

re-use as this needs to be considered when working within a globally addressable memory. The

directive and dependence browsers can be trsed together with any additional information the user

may wish to offer to re-examine if the variable(s) concerned can be privatized. In the process,

dependencies into or out of the loop are examined to test if the variable could be made PRIVATE,
or to re-examine if the loop carried pseudo dependencies are needed, in an attempt to allow the

loop to execute in parallel.

iv. Reduction loops - The analysis is used to determine if the loop body computations represent a

global reduction operation such as a MAX or summation. These loops provide a partial update of

the results by each thread followed by a global update to give the final reduction value.

v. Pipeline loops - This is a special class of serial loops with loop-carried true dependencies. Directive-

based software pipelines can be used to good effect in parallel. Figure 5 shows an example where

OpenMP function calls are used to define the pipeline start-up before the J-loop and the pipeline
shutdown after the loop. The example is taken from a version of the NAS LU benchmark. This is a
similar strategy to that adopted for a software pipeline used In a distributed memory

parallelization with message passing. For comparison a software pipeline implementation using a

high level message passing library (CAPLib) is shown in the lower panel of Figure 5. CAPLib is a
thin layer that covers a choice of message passing libraries such as PVM, MPI, Cray Shmem etc.

vi. Chosen parallel loops - These are the parallel loops at which the OMP DO construct is defined. These

loops may contain serial or parallel loops within their nesting but are not surrounded by other

parallel loops.

vii. Not chosen parallel loops - Also parallel loops, but these have not been selected for application to the

OMP DO directive. This is because these loops are surrounded by other parallel loops at a higher

nesting level. In general, the OpenlVIP compiler suppliers do not cttrrently support nested

parallelism, therefore, even though parallelism exists at these lower levels, it is not currently

exploited.

The sub filter can be used together with the loop filter to control the finer selection of loop types.

Detailed explanation of these filters can be found in Appendix 3.2 and examples of using the loop filters
are in Tutorials.
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(a) !loop = jend-jst

if (lloop .gt. mthnum) lloop = mthnum

iam = omp_get_thread num()

if (iam .gt. 0 .and. Jam .le. lloop) then

neigh = iam - 1

do while (isync(neigh) 0)

!$OMP FLUSH(isync)

end do

isync(neigh) = 0

!$OMP FLUSH(isync)
endif

!$OMP DO SCHEDULE(STATIC)

do j=jst,jend, l

do i=ist,iend, l

c forward elimination and back

enddo

enddo

!$OMP END DO nowait

if (Jam .it. lloop) then

do while (isync(iam)

!$OMP FLUSH(isync)
end do

isync(iam) = 1

!$OMP FLUSH(isync)
endif

•eq.

substitution for diag.

.eq. I)

block inversion

_) CALL CAP_RECEIVE(v(I,2,LOW-I,k),nx0*5-10,3,CAP LEFT)

do j=MAX(jst,jst+LOW-2),MIN(jend, jst+HIGH-2),I

do i=ist,iend,l

c forward elimination and back substitution for diag. block inversion

enddo

enddo

CALL CAP SEND(v(I,2,HIGH,k),nx0*5-10,3,CAP_RIGHT)

Figure 5: Implementation of a software pipeline for routine BLTS using (a) OpenMP (b) message passing.

4.2. Browsing Different Types of Loops

The accurate dependence analysis allows the algorithm to automatically generate efficient OpenMP

code in many cases. Experience has shown that this typically leaves a small proportion of cases that

require user interaction. For example, the use of workspace arrays is very common in application codes,

but the value-based nature of the dependence analysis will often prove that no data is passed between

iterations of a loop. The memory re-use (pseudo) dependencies must however be set. This correctly

does not classify such loops as serial, however, the legal privatization of these arrays to allow parallel

execution requires that no data is passed into or out of these arrays from or to outside the loop. The

value-based analysis, again greatly aids in proving that no such dependencies into or out of the loop
exist.

Normally the user wants to go through the following loop types and use the WhyDirectives window to

find out the reason for a particular loop type:

• Totally Serial->True Recursion

• Covered Serial->True Recursion
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• Falsely Seria!->Prlva%ization

• Chosen->CopyIn/Out

• Loop: _acld:1/1/160: do n-l.r_.l

Type: Falsely Serial New Type.. ) Antl-dep. variables

Hints:

4 vari_las with ].oop-cLrried

OUtlet _m_hm=iee (1e_1-I)

md _-p¢i_Ueablh, due
ua_ge frol out_ido the _op

4 out_?uC-dop (>) variab_,
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. "_< ._ CAPO: Why, Directives ? " -.. :...... " : "

. Reason: anti/output dependencies, variable not privaUzabie

Output-dep.varlables In/out-dep. varlables

t | . . . . )¢

b >b
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,L

Contslns parallel loops:

J

Select All ) Select All )

_ _..b._.,,

Inside parallel loops:

li
Select All )

Dismiss )

lili
Figure 6: The WhyDirectives window for a falsely serial loop.

The WhyDirectives window (as shown in Figure 6) can be activated by clicking on the _ button in

the Directives Browser window once a loop is selected. The window displays information on variables

that cause a loop to be so classified. The cause for a loop not to be parallel can come from several

sources, for example, loop-carried TRUE/ANTI/OUTPUT dependence, non-privatizable variables (re-
use of memory). If one is sure that some of these dependences are false (mostly due to lack of input
information for the dependence analysis) and can be removed, the Dep-Graph browser can be used to

modify the dependence graph. A shortcut is provided in the WhyDirectives window where variables
can be selected from the variable-list boxes and the relevant dependences can be removed by clicking

the _ button. The following relevant dependences will be removed, based on the loop type and

variable list type:

Loop Type Variable List Dependence Type

Totally Serial True-dep. Loop-carried TRUE dependence

Anti-dep. Loop-carried ANTI dependence

Output-dep. Loop-carried OUTPUT dependence

Covered Serial True-dep. Loop-carried TRUE dependence

Anti-dep. Loop-carried ANTI dependence

Ou tput-dep. Loop-carried OUTPUT dependence

Falsely Serial Anti-dep. Loop-carried ANTI dependence

Output-dep. Loop-carried OUTPUT dependence

In/Out-dep. TRUE dependence from outside of the loop

Chosen Parallel Copyin/Out TRUE dependence from outside of the loop
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Once a change to the dependence graph (either via the Dep-Graph browser or via the WhvDirectives

browser) is made, be sure to save the change to the database (File--+Save Database) and re-perform the
directive analysis (_date Directives...] button).

4.3. Enforcing New Loop Type

A loop type as described in the previous section and defined by CAPO can be overridden by the user

with the LoopType dialog box which is activated from the _ button (see Figure 6). Typically

this may occur when a loop is chosen for parallelization by CAPO but does not have proper granularity.
The user may want to force it to be serial and let the tool choose another loop that is nested inside this

loop. Another possibility is when the user wants to enable parallelization for a loop that contains I/O
statements.

Currently the following four types are selectable:

Parallel

Serial

Reduction

Break

- from parallel without granularity or with I/O statements
- from parallel loop, including reduction

- from serial loop with loop-carried true dependence

- from any other types.

Only the conversions as indicated are possible from the dialog box. Although loop types can be

redefined from the user-defined loop file (see Appendix 1.3), use of the LoopType dialog box is safer.

However, one should keep in mind that changing the loop type manually could potential lead to
incorrect results if the above rule is not carefully followed.

4.4. Routine Duplication

Routine duplication is performed after all the loop-level analyses and optimization are done but before

directives are inserted. A routine may be duplicated if it causes usage conflicts at different calling

points. For example, if a routine contains parallel regions and is called both inside a parallel loop and
outside another parallel loop but still inside a parallel region, the routine is duplicated so that the copy

of the routine without directives is used inside the parallel loop and the second copy containing only

orphaned directives without "OMP PKRKLLEL" is used inside parallel regions but outside parallel
loops. Routine duplication is often used in a message-passing program to handle different data
distributions in the same routine.

There are two selectable types of routine duplication (see the Settings in Appendix 3) for a routine that

contains parallel regions in the dynamic extent of this routine:

• 'Loop' as the type for routine duplication if the routine is called both inside and outside
parallel loop(s).

• 'Region' as the default type for routine duplication if the routine is called inside parallel loop(s)
and inside parallel region(s) but outside parallel loop(s).

This first option removes any nested parallelization. The second option confirms the OpenMP standard

that a parallel region can be nested inside a work-sharing construct (parallel loop) but not inside a
parallel region.

The RoutineDup browser (from View--_irectives-+RoutDup) is used for browsing routines that will
be duplicated. The browser will indicate those calls that are inside parallel loops and those that are

outside parallel loops. One may inspect the calls that are outside parallel loops for possible

improvements, for example, de-serializing any potential outside loop nests.
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5. Other Features

5.1. CAPO Parameters and Log Information

Parameters are referring to inputs that user can supply to control the behavior of directive generation in

CAPO. A list of all the parameters is given in Appendix 1. These parameters can be defined from a file,
environment variables, the Setting window in the Directives Browser, or the CAPO command interface.

All the parameters have their default values. The Setting window from the Directives Browser is the
most straightforward way to change parameters. It allows a user to select the log information type,

define the directive type, set the loop granularity for parallelization, enable/disable the generation of

the THREADPRIVATE directive, etc. For example, if the Directive Type is set to No Directive, the

generated code will not contain directives and any associated transformations as indicated in the next
sectior_

By default, the process of automatic insertion of directives is logged to the log-file "code-

output, log". Information in thisfilemay be examined afterdirectivesare added. There are three

main sectionsin thelog file,asoutlinedinAppendix 2. Depending on the log-infotype,differentlevels

of information details may be logged. In general, the log-info type controls:

1) min -- only minimum amount of information, such as WARNING and INFO messages,

2) std -- information from rain, plus summary for each routine and each region,

3) more -- information from std, plus more detailed results for each loop and each region,

4) debug --information from more, plus additional debug information that are probably too

much for an ordinary user.

Warning messages in the log file should be paid enough attention since they indicate potential problems

in the generated parallel code, which may be caused by user's interaction or bug in the tool.

5.2. Automatic Code Transformation and Optimization

CAPO performs the following code transformation and optimization automatically and logs the actions

into the log file.

• Removal of the end-of-loop synchronization (using the NOWAIT construct) if it is proved valid.

The function can be switched off from the parameter setting.

• Loop nest interchange to improve cache performance. The array usage is analyzed against the

loop nesting order for possible misalignment. Loop transformation is performed to reduce

misalignment. The module is activated only when the 03 optimization is chosen.

• The ability to treat private variables with unknown size. A variable with unknown size is
usually declared as " ( * ) " (sometime as " ( 1 ) ") for its last dimension in a subroutine. Use of
such a variable as PRIVATE in a parallel region would cause ambiguity in size declaration and

likely rLm-time error. In the current implementation, variable size is automatically detected
(back tracing and usage checking) and dimension adjustment is then performed.

• Reduction of an array is transformed into local array updates plus a global update in a critical
section at the end.

• Detection of reduction via an IF statement. The reduction is automatically transformed to local

updates and a global update in a critical section at the end. This type of reduction is indicated
as IMIN or IMAX in the Directives Browser.
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5.3. Command Interface and the Batch Mode

The command interface for CAPO is available in Version 1.1 and works closely with the CAPTools"

command interface. It provides a way to access the functionality of GU1 components without starting
the components. It serves as a mean to record actions (to a log file) as a result of any user GUI activities

so that these actions can be played back later. The commands in the command interface are usually
recorded to a log file or a command file with

capo -logfile capo_run.cmd

and played back with

capo [-batch] capo_run.cmd.

The second line with the [-batch] option can be used to start a CAPO session in a batch mode. This is

especially useful for the data dependence analysis since it is the most CPU intensive part and very little

use interaction is required once the analysis is started. Refer to Appendix 4 for a list of CAPO
commands and several useful CAFFools commands for the command interface.

5.4. Parallel IIO

Strictly speaking parallel 1/O is not supported in CAPO. I/O is serialized by default, i.e., it is handled

by the master thread only. If any I/O is in the dynamic extent of a loop nest, the loop will be executed

sequentially. However, in some cases, one may want to exploit" parallel I/Os. For example in the
following code:

DO K=I,NZ

IF (V(K) .LT.0.0) THEN

WRITE(*,*) 'Warning: Negative value at K=', K
ENDIF

END DO

The WRITE statement prints a warning message only when a condition is reached. The order of the

write statement is not important, thus, one may seek for parallelizing the loop nest.

Another commonly encountered case is that warning messages are printed inside subroutine calls while
data are read/written in the current scope of a loop nest. One may want to ignore the warning

messages inside subroutine calls but serialize loops containing I/O in the current scope.

The level of parallel I/O in CAPO is controlled by the parameter "CAPO PIO". If a value of "incall" is

given, CAPO will ignore any l/Os inside subroutine calls when parallel loops are considered. Another
possible value is "write", which allows any WRITE to stdout (UNIT=* or 6) inside parallel loops. This

can be used for the above example. Of course, one can always enforce a user-defined loop type. During

the code generation warnings will be printed in the log file if 1/O is encountered inside a parallel

region. One can examine these warnings for potential problems.

5.5. Mix of Message Passing and OpenMP

As pointed out in Section 2, CAPTools is designed to generate message-passing codes while CAPO is

used to create OpenMP codes. Mixing message passing (such as MPI) and OpenMP is possibie in the

framework of CAPTools/CAPO since the two tools are integrated together. A commonly used hybrid

model is to have MPI for the coarse-grained parallelization and OpenMP for the fine-grained

parallelization. Such a parallelization model is very effective if an application can be divided into
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domains and different domains are only loosely coupled. MPI is used for inter-domain parallelism and

OpenMP for intra-domain parallelism.

Tutorial 5 gives an example of producing a mixed parallel code for the NAS BT benchmark. Although in

general there is no particular good reason that you want to mix MPI and OpenMP within the same

domain because of poor performance, the tutorial simply illustrates the capability of the tools to

generate mixed codes.
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6. Case Studies

For completeness in this section we present case studies of using CAPO to parallelize the NAS parallel
benchmarks and two computational fluid dynamics (CFD) codes well known in the aerospace field:

ARC3D and OVERFLOW. The parallelization process described in Section 3 was followed. We mainly

present the results and discuss issues encountered in the parallelization. Most of the results have been
reported in Ref. [6].

In the case studies, we used an SGI workstation (R5K, 150MHz) and a Sun El0000 node to run CAPO.

The resulting OpenMP codes were tested on an SGI Origin2000 system, which consisted of 64 CPUs and

16 GB globally addressable memory. Each CPU in the system is a R10K 195 MHz processor with 32KB

primary data cache and 4MB secondary data cache. The SGI's MIPSpro Fortran 77 compiler (7.2.1) was

used for compilation with the "-03 -rap" flag.

6.1. The NAS Parallel Benchmarks

The NAS Parallel Benchmarks (NPBs) were designed to compare the performance of parallel computers

and are widely recognized as a standard indicator of computer performance. The NPB suite consists of

five kernels and three simulated CFD applications derived from important classes of aerophysics
applications. The five kernels mimic the computational core of five numerical methods used by CFD

applications. The simulated CFD applications reproduce much of the data movement and computation
found in full CFD codes. Details of the benchmark specifications can be found in Refs. [1] and [2].

In this study we used six benchmarks (LU, SP, BT, FT, MG and CG) from the sequential version of

NPB2.3 [21 with additional optimization described in [5]. Parallelization of the benchmarks with CAPO

is straightforward except for FT where additional user interaction was needed. User knowledge on the

grid size (>_ 6) was entered for the data dependence analysis of BT, SP and LU. In all cases, the

parallelization process for each benchmark took from tens of minutes up to one hour, most of the time
being spent in the data dependence analysis. The performance of CAPO generated codes is summarized

in Figure 7 together with comparison to other parallel versions of NPB: MPI from NPB2.3, hand-coded
OpenMP [5], and versions generated with the commercial tool SGI-PFA [101.

CAPO was able to locate effective parallelization at the outer-most loop level for the three application

benchmarks and automatically pipelined the SSOR algorithm in LU. As shown in Figure 7, the

performance of CAPO-BT, SP and LU is within 10% to the hand-coded OpenMP version and much

better than the results from SGI-PFA. The SGI-PFA curves represent results from the parallel version
generated by SGI-PFA without any change for SP and with user optimization for BT (see [10] for

details). The worse performance of SGI-PFA simply indicates the importance of accurate

interprocedural dependence analysis that usually cannot be emphasized in a compiler. It should be
pointed out that the sequential version used in the SGI-PFA study was not optimized, thus, the

sequential performance needs to be cotmted for the comparison. The hand-coded MPI versions scaled
better, especially for LU. We attribute the performance degradation in the directive implementation of

LU to less data locality and larger synchronization overhead in the 1-D pipeline used in the OpenMP

version as compared to the 2-D pipeline used in the MPI version.

The directive code generated by CAPO for MG performs 36% worse on 32 processors than the hand-

coded version, primarily due to an unparallelized loop in routine norm2u3. The loop contains two

reduction operations of different types. One of the reductions was expressed in an IF statement, which
was not detected by CAPO Version 1.0 (the IF reduction will automatically be detected by Version 1.1),

thus, the routine was ran in serial. ALthough this routine takes only about 2% of the total execution time

on a single node, it translates into a large portion of the parallel execution on large number of
processors, for example, 40% on 32 processors. All the parallel versions achieved similar results for CG.
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Figure 7: Comparison of the OpenMP NPB generated by CAPO with other parallel versions:

MPl from NPB2.3, OpenMP by hand, and SGI-PFA.

The basic loop structure for the Fast Fourier Transform (FFT) in one dimension in FT is as follows.

DO K=I, D3

DO J=l, D2

DO I=l, D1

Y(I) = X(I,J,K)

END DO

CALL CFFTZ (.... Y)

DO I=l, D1

X(I,J,K) = Y(I)

END DO

END DO

END DO

A slice of the 3-D data (X) is first copied to a 3-D work array (Y). The 1-D FFT routine CFFTZ is called to

work on Y. The returned result in Y is then copied back to the 3-D array (X). Due to the complicated

pattern of loop limits inside CFFTZ, CAPTools could not disprove the loop-carried true dependences by

the working array Y for loop K. These dependences were deleted by hand in CAPO to identify the K

loop as a parallel loop.

The resulted parallel FT code gave a reasonable performance as indicated by the curve with filled circles

in Figure 7. It does not scale as well as the hand-coded versions (both in MPI and OpenMP), mainly due

to the unparallelized code section for the matrix creation which was artificially done with random

number generators. Restructuring the code section was done in the hand-coded version to parallelize

the matrix creation. Again, the SGI-PFA generated code performed worse.

6.2. ARC3D

ARC3D is a moderate-size CFD application. It solves Euler and Navier-Stokes equations in three

dimensions using a single rectilinear grid. ARC3D has a structure similar to NPB-SP but contains curve
linear coordinates, turbulent models and more realistic boundary conditions. The Beam-Warming

algorithm is used to approximately factorize an implicit scheme of finite difference equations, which is

then solved in three directions alternatively.
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For generating the OperuMP parallel version of ARC3D, we used a serial code that was already

optimized for cache performance by hand [9]. The parallelization process with CAPO was

straightforward and OperuMP directives were inserted without further user interaction. The parallel
version was tested on the Origin2000.and the result for a 194x194x194-size problem is shown in the left

panel of Figure 8. The results from a hand-parallelized version with SGI multi-tasking directives (MT by

hand) [9] and a message-passing version generated by CAPTDols (CAP MPI) [6] from the same serial

version are also included in the figure for comparison.

As one can see from the figure, the OpenMP version generated by CAPO is essentially the same as the
hand-coded version in performance. This is indicative of the accurate data dependence analysis and

sufficient parallelism that was exploited in the outer-most loop level. The MPI version is about 10%
worse than the directive-based versions. The MPI version uses extra buffers for communication and this

could contribute to the increase of execution time.

6.3. OVERFLOW

OVERFLOW is widely used for airflow simulation in the aerospace community. It solves compressible

Navier-Stokes equations with first-order implicit time scheme, complicated turbulence model and

Chimera boundary condition in multiple zones. The code has been parallelized by hand [4] with several
approaches: PVM for zone-level parallelization only, MPI for both inter- and intra-zone parallelization,

multi-tasking directives, and multi-level parallelization. This code offers a good test case for our tool not
only because of its complexity but also its size (about 100K lines of FORTRAN 77).

In this study, we used the sequential version (1.8f) of OVERFLOW. CAPO took 25 hours on a Sun E10K

node to complete the data dependence analysis. A fair amount of effort was spent on pruning data

dependences that were placed due to lack of necessary knowledge during the analysis. An example of
false dependence is illustrated in the following code segment:

i00

NTMP2 = JD*KD*31

DO i00 L=LS,LE

CALL GETARX(NTMP2,TMP2,ITMP2)

CALL WORK(L,TMP2(ITMP2,1),TMP2(ITMP2,7} .... }

CALL FREARX(NTMP2,TMP2,ITMP2)

CONTINUE

Inside the loop nest, the memory

space for an array TMP2 is first

allocated by GETARM. The working

array is then used in WORK and
freed afterwards. However, the

data analysis has reviewed that the
loop contains loop-carried true

dependences caused by variable

TblP2, thus, the loop can only be
executed in serial. The memory
allocation and de-allocation are

performed dynamically and cannot

be handled by CAPO. This kind of
false dependence can safely be

removed with Dependence Browser
included in the tool. Even so, CAPO

provides an easy way for user to
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Figure 8: Comparison of execution times of CAPO generated parallel
codes with hand-coded parallel versions for two CFD applications:
ARC3D on the left ,nd OVERFLOW on the right.
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interact with the parallelization process. The OpenMP version was generated within a day after the

analysis was completed and an additional few days were used to test the code.

The right panel of Figure 8 shows the execution time per time-iteration of the CAPO-OMP version

compared with the hand-coded MPI version and hand-coded directive (MT) version. All three versions

were running with a test case of size 69x61x50, 210K grid points in single zone. Although the scaling is

not quite linear (when comparing to ARC3D), especially for more than 16 processors, the CAPO version

out-performed both hand-coded versions. The MPI version contains sizable extra codes [4] to handle
intra-zone data distributions and communications. It is not surprising that the overhead is unavoidably

large. However, the MPI version is catching up with the CAPO-OMP version on large number of

processors. On the other hand, further review has indicated that the multi-tasking version used a fairly

similar parallelization strategy as CAPO did, but in quite a few small routines the MT version did not

place any directives for the hope that the compiler (SGI-PFA in this case) would automatically

parallelize loops inside these routines. The performance number seemed to have indicated otherwise.

We also tested with a large problem of 1.5M grid points. The result was not incl-ded in the figure but

CAPO'_ v_rsion has achieved 18-fold speed_lp on 32 vroc_ors of the Origin2000 (10 out of 32 for the
small test case). It is not surprising that the problem-with large grid size has act'ueved better parallel

performance.
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1. Parameters for CAPO

The following describes parameters available in Version 1.1.

1.1. General

Parameters are referring to inputs that user can supply to control the behavior of directive generation in

CAPO. There are default settings for all the parameters (see Section 1.3). Parameters can be defined

from a file, environment variables, or the Setting box in the Directives Browser. Values from the

parameter file or environment variables supersede any defaults. Values from the parameter file

supersede environment variables. Changes from the Setting box (Section 3.5) in the Directives Browser

are applied at last. Parameter setting can also be done from the CAPO command interface. See Section 4
for details.

1.2. The Parameter File

The parameter filename can be defined via the environment variable CAPO_PAK The default filename is

"capo-inp. par" in the current directory. An example of this file is given in Section 1.5.

Format of the parameter file:

,#,

'key value'

the sign starts a comment

the pair defines an entry

1.3. Parameter Keys and Possible Values

ENV_ VAR IAB LE KEY DEFAULT POSSIBLE VALUES

CAPO_PAR

CAPO_LOG

CAPO_LOGNAME

CAPO_LOGINFO

CAPO_PLOOP

CAPO_TYPE

CAPO_REGION

CAPO_OPTIMIZE

CAPO_USERLOOP

CAPO_DIRCLEAR

CAPO_TPRIV

CAPO_COMMENT

CAPO_USEPARTI

CAPO_RDUPTYPE

CAPO_UNKSIZE

CAPO_PIO

log-file

log-file-name

log-info

loop-granularity

directive-type

region-type

optimize-type

user-loop-file
directive-clear

tpriv-directive

comment-type

use-patti-loop

rdup-type

allow-unksize

allow-pio

capo-inp.par

on (off on stdout)

codeoutput.log

std (min std more debug)

6 (0 1 2 ...)

omp (omp sgi sgix no)

default (loop bloop one join full)

02 (off on 02 03)

user-loop.par

default-list (off on filename)

on (off on)

fg0 (f77 f90)

no (no yes)

region (loop region)

false (false true)

no (no incall write noread

any)
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Description of the parameters:

• "log-file" type is one of

of f -- Logging to file is off, only minimum messages are printed on screen

on -- Information are logged to the log-file

s tdout -- Information are printed to stdout (screen)

• "log-file-name" defines the name for a log file. If no name is defined, CAPO will tkse the

output filename from the code generation to form a log filename. Contents of the log file are
described in Section 2.

• "log-info" type is one of

min -- Only minimum information are logged or printed

s td -- Print standard set of log information

more -- Print more detailed log information, including region and loop numbers in the final
Fortran file

debug .... Print debugging information, probably more than you want, including region and

loop numbers in the final Fortran file

• The loop granularity is based only on the loop iterations at this point. Future extension to

include profile information can easily be added.

Currently supported directive types are

omp

sgi

sgix

-- Produce OpenMP directives (default)
-- Produce SGI native directives

Produce OpenMP directives with SGI extensions. Currently, only the 'NEST'

directive is supported

-- Do not insert directives in code generation (useful for comparison).no

• Different region types

1oop -- consider only one loop for one region (no pipeline)

bloop --consider one block + one loop for one region (no pipeline)

one -- consider one region (region not joined, no pipeline)

join -- consider joined region (outer loop nesting, no pipeline)

ful 1 -- consider full region (region joined and possible pipeline)

For SGI directives, only "loop" is allowed for the region type (region-type). The default region-

type is "loop" for SGI and "full" for OMP.

• Optimization type is intended for possible improvements to be applied, such as loop

granularity check, synchronization overhead reduction, and loop transformation. Currently an
attempt to reduce synchronization at end-of-loop is implemented. Other optimizations are less
defined and/or tested.

o ff -- Do not do any optimization

on -- Try to reduce synchronization at end-of-loop

o2 -- Use logical disprove (slow sometime) for affinity comparison

o3 -- Perform additional optimization (such as loop transformation) before loop analysis
and directive insertion.

• User-defined loop types are read from a file that can be defined via environment variable

CAPO_USERLOOP or "user-loop-file" entry in the parameter file. If a "userloop. par" file
exists in the current working directory, this file will be taken if the other two methods are not
used. The format of this file is:
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# starts comm_en%

#RoutineName LoopNumber NewType

routine_name loop_count S1 PIRIB[optiOnsl

Entries are specified line-by-line. "Routine_name" is case insensitive. For a program without
the main-routine name defined, "MAIN" can be used to indicate the main routine.

"loop_count" is the loop number counted from the beginning of a given routine. A negative

"loop_count" indicates the loop (defined by -loop count) will not be considered for

automatic loop transformation.

Currently the following new loop types are supported:

"s" for serial

"p" for parallel
"R" for reduction

"B" for break-type (e.g. so that a parallel region won't be formed around this loop).

The "R" type can optionally be attached with

"[OPR :VAR]" or "[OPR :VAR ()]" list

to indicate the reduction operator and the reduction variable, no space in-between. The second
form indicates an array reduction_

• List of directives to be cleared can be read from a file or taken from the default list. The default

list contains the following:

"cdir$", /* Cray vector directive */

"cmic$", /* Cray autotasking directive */

"cSpar", /* PCF (Parallel Computing Forum) directive */

"cSdoacross", "c$&", /* SGI multiprocessing directive */
"c$ ", "c$\t",

"c$omp", /* OMP directive */

"cSsgi" /* SGI OMP extension */

The default setting is to use the above list. The 'clearing' action may be turned off by setting

CAPO_DIRCLGAR to 'off'. Additional directives may be added to the default list by prefixing a
'+' in front of the filename for CAPO_DIRCLEAR.

A dirclear-list file contains simply a list of directives (keywords) to be considered. A keyword

should lead with one of ['C', '! ', '*']. A '-' sign can be added to the front of a keyword to indicate
the corresponding directive should not be cleared (i.e. keep its original form), otherwise, the
directive will be commented out (cleared).

• The THREADPRIVATG directive will be generated by default. If the option is turned off via

CAPO_TPRIV (=off), CAPO will use an alternative method to treat private variables used in a
common block.

off --Use an alternative method to handle private variables

on --Try to create THREADPRIVATE directives

• The comment type refers to the leading character to be used for directives. The 'C' character is

for the f77 type and the '!'character is for the f90 type. Default is '! '.

• By default, if a loop is partitioned in a message-passing program, the loop will not be

considered for directives (CAPO_USEPARTI=no). This is equivalent to a two-level

parallelization. If a partitioned loop is intended for directives as well, CAPO_USEPARTI can be

set to 'yes'. This would be a one-level parallelization with mixed type. The option is only
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meaningful when CAPTools is first ttsed to generate message-passing program and CAPO is

then applied to insert directives.

• Two types of routine duplication (RDUP) can be selected:

1 oop -- as the type for RDUP if a routine is used both inside and outside parallel loop(s).

region -- as the (default) type for RDUP if a routine is used inside a parallel loop and inside

parallel region but outside parallel loop.

The second option allows nested parallel regions and confgrns the OpenMP standard that a

parallel region can be nested inside a parallel loop but not inside a parallel region.

• The environment variable CAPO_UNKSIZE controls how tmknown-size private variable (USPV)
is treated. A unknown-size variable has its last dimension declared as ..... or "1" in a subroutine

and is in the routine argument list. By default, if an USPV is encountered, CAPO will take
effort to adjust the size of the unknown dimension. If the size cannot be adjusted, the

corresponding loop will be made serial. If CAPO_I./NKSIZE is set to "true", the loop with
USPV will not be made serial, instead, a warning will be printed so that the user can make

manual change later on.

• By default I/O statements are not allowed in the dynamic extent of parallel loops. However,

one can exploit certain degrees of parallel I/O with CAPO_PIO.

no -- no I/O statements in the dynamic extent of a loop (default).

incal i -- no I/O in the current scope of a loop, but allowed inside subroutine calls.

write -- allow "WRITE(*,*)", i.e. write to standard output.

noread -- no READ, but allow any WRITE.

any -- allow any type of I/O statements.

1.4. Parameters for Debugging Purpose

The following parameters are only available from the Setting box (Section 3.5) in the Directives browser.
By default, all these parameters are enabled. The Setting box can be used to disable them for debugging

purpose.

Generate-NOWAIT

Transform-Induction-Loop

Handle-Array-Reduction

Remove-Old-Directives

Apply-UserLoop-Type

Setup-Pipeline-Loop

-- enable/disable the NOWAIT directive

-- enable/disable induction loop treatment

--enable/disable array reduction

enable/disable removing old directives

-- enable/disable applying userloop types

-- enable/disable pipeline loop

1.5. Sample Parameter File

# env: CAPO_PAR
# Parameters for CAPTools-based

# They apply to version I.I

Parallelizer with OperuMP (CAPO )

# env: CAPO_LOG

# defines if log-information is wanted

log-file on (off on stdout

# env: CAPO_LOGNAME
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# defines log-file name when log-file = on

log-file-name (default: codeoutput.log)

# env: CAPO_LOGINFO

# defines type of information to be logged

log-info std (min std more debug)

# env: CAPO_PLOOP

# defines granularity (min. no. of iters.) for parallel loops

loop-granularity 6 (0 1 2 ...)

# env: CAPO_TYPE

# defines type of directives to be produced

directive-type omp (omp sgi sgix no)

# env: CAPO_REGION

# defines type of parallel regions to be considered

region-type full (loop bloop one join full)

# env: CAPO_OPTIMIZE

# defines optimization type for parallel regions

optimize-type o2 (off on 02 03)

# env: CAPO_USERLOOP

# defines the file name for user-defined loop types

user-loop-file (default: user-loop.par)

# env: CAPO_DIRCLEAR

# defines the file name for directives to be cleared

directive-clear Default (off on filename)

# env: CAPO_TPRIV

# switches on/off the generation of THREADPRIVATE

tpriv-directive on (off on)

# env: CAPO_COMMENT

# chooses a comment type for directives

comment-type f90 (f77 f90)

# env: CAPO_USEPARTI

# uses partitioned loops for directives

use-parti-loop no (no yes)

# env: CAPO_RDUPTYPE

# defines routine duplication type

rdup-type region (loop region)

# env: CAPO_UNKSIZE

# allows unknown-size variables

allow-unksize false (false true)

# env: CAPO_PIO

# allows parallel I/O

allow-pio no (no incall write noread any)
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2. Messages and Symbols in the Log File

By default, the process of automatic insertion of directives is logged to the log-file "code-

output, log". Information in this file may be examined after directives are added. There are three
main sections in the log file, as outlined in the following subsections. Depending on the log-info type as

described in Section 1, different levels of information details may be logged. In general, the log-info

type controls:

1 ) rain -- only minimum amount of information, such as WARNING and INFO messages,

2) std -- information from min, plus summary for each routine and each region,

3) more -- information from std, plus more detailed results for each loop and each region,

4) debug -- information from more, plus additional debug information that are probably too
much for an ordinary user.

In the case of "more" and "debug", additional labels _ and _ are added as comments tot

parallel loops in the generated parallel code. Regions and loops are labeled within a given routine,

sequentially.

2.1. Classification of Loops

The first section lists the analysis of loops in all routines from the dependence information. For a given

routine a loop is labeled with its sequence number, the group number and the loop-nesting level. The

group number is defined as a sequence number for a loop-nest group at a given nesting level. Loops are
classified as parallel, serial, or possible pipeline. For a parallel loop, it is further tested for granularity

and is indicated if a parallel directive is to be added; provided the loop is not nested inside another

parallel loop. For a serial loop, the reason of serialization as well as the first variable that causes the

loop to be serialized is given. The causes of loop serialization include loop-carried dependences (true,
anti and output), I/0 statement inside, and breaking out of the loop. A pipeline loop is a serial loop

with only loop-carried true dependences and determinable dependence vectors. The basic information

for loops is as the following:

Routine: ROUTINE_NAME

Loop # (loop_variable), group #,

TYPE? Reason for serial...

level #: parallel/serial

"TYPE?" is one of types from the loop type list:

"REDU", "NPAR", "PAR", "IO", "LVAR", "SER", "ANTI", "PIPE",

"BRK", "UPIPE", "PAREG", "INDU", "INPLP", "RDINP", "GRAN", "PARTI"

As an example, part of the analysis _r three routines in NPB-LU is given here (with tog_info set to
MORE).

Routine: BUTS

Loop 1 (J), group I, level i: parallel, granularity - ok

PAR-> directives to be added for the loop <I,I>

Loop 2 (I), group i, level 2: parallel, granularity - ok

INPLP? no directive, loop inside a parallel loop

Loop 3 (M), group I, level 3: parallel, granularity - no

Loop 4 (J), group 2, level I: serial

CAPO User Manual A-7



APPENDIX: MESSAGES AND SYMBOLS IN THE LOG FILE

PIPE? true dependence, pipeline loop? dvector: V[0 3 -i 0]

Loop 5 (I), group 2, level 2: serial

PIPE? true dependence, pipeline loop? dvector: V[0,-I.0.0]

Loop 6 (M), group 2, level 3: parallel, granularity - no

Loop 7 (M), group 2, level 3: parallel, granularity - no

*** Total number of loops: 7, parallel: 5, serial: 2, directive: 1

Routine: JACU

Loop 1 (J), group I, level I: parallel, granularity - ok

PAR-> directives to be added for the loop <i,i>

Loop 2 (I), group I. level 2: parallel, granularity - ok

INPLP? no directive, loop inside a parallel loop

*** Total number of loops: 2, parallel: 2, serial: 0, directive: 1

Routine: SSOR

Loop 1 (1), group I, level i: serial

ANTI? loop carried output or non-exact anti dependence: ELAPSED

Loop 2 (I)0 group 2, level i: serial

ANTI? loop carried output or non-exact anti dependence: ELAPSED

Loop 3 (ISTEP), group 3, level I: serial

BRK? break out of the loop or comm-call inside the loop

Loop 4 (K), group 3, level 2: parallel, granularity - ok

PAR-> directives to be added for the loop <2,1>

Loop 5 (J), group 3, level 3: parallel, granularity - ok

INPLP? no directive, loop inside a parallel loop

Loop 6 (I), group 3, level 4: parallel, granularity - ok

INPLP? no directive, loop inside a parallel loop

Loop 7 (M), group 3, level 5: parallel, granularity - no

Loop 8 (K), group 3, level 2: serial

SER? loop carried true dependence: ELAPSED

Loop 9 (K), group 3, level 2: serial

SER? loop carried true dependence: ELAPSED

Loop 10 (K), group 3, level 2: parallel, granularity - ok

PAR-> directives to be added for the loop <2,2>

Loop II (J), group 3, level 3: parallel, granularity - ok

INPLP? no directive, loop inside a parallel loop

Loop 12 (I)0 group 3, level 4: parallel, granularity - ok

INPLP? no directive, loop inside a parallel loop

Loop 13 (M), group 3, level 5: parallel, granularity - no

*** Total number of loops: 13, parallel: 8, serial: 5, directive: 2

>>>> Grand total: num_routines 25, hum_loops 157

loops: parallel 145, serial 12, directive 30

The label for a parallel loop with directive to be added (PAR->) is given as <level, group> pairs. In

the case of a serial loop only one variable is listed for the cause of serialization. For a potential pipeline

loop, the dependence vector for the first related variable is given, as the case of v [ O, O, -1,0 ] for loop

4 (J) in routine BUTS.

The user-defined loop types are applied after the loop classification. Therefore, it is user's responsibility
to ensure the correctness of user-supplied loop types.

2.2. Construction of Parallel Regions

This section contains first the summary from the pass-two analysis of all the routines in the outer-most
loop level to decide if directives need to be added in a routine. Routines are traversed on their call
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sequences. A <yes> or <no> flag is marked for each analyzed routine to indicate the addition of
directives in the routine. A routine may need to be duplicated if it is called both inside and outside a

parallel loop and will contain directives in itself.

Routine: ROUTINE_NAME <yes/no/inploop/noploop>

<yes>

<no>

<inploop>

<noploop>

-- routine is added with directives for parallel loops

-- routine has no directives

-- routine is called inside a parallel loop

-- routine has no parallel loop, but may contain potential pipeline loops

A sample result from the analysis of NPB-LU looks like the following.

Routine: APPLU <yes>

Routine: READ_INPUT <no>

Routine: DOMAIN <no>

Routine: SETCOEFF <no>

Routine: SETBV <yes>

Routine: SETIV <yes>

Routine: ERHS <yes>

Routine: SSOR <yes>

Routine: TIMER_CLEAR <no>

Routine: JACLD <yes>

Routine: BLTS <yes>

Routine: JACU <yes>

Routine: BUTS <yes>

Routine: RHS <yes>

Routine: TIMER_START <no>

Routine: L2NORM <yes>

Routine: TIMER_STOP <no>

Routine: ELAPSED_TIME <no>

Routine: WTIME <no>

Routine: ERROR <yes>

Routine: EXACT <no>

Routine: PINTGR <yes>

Routine: VERIFY <no>

Routine: PRINT_RESULTS <no>

Routine: TIMER_READ <no>

>>> Total routines: 25, checked: 24, with directives: 13

in/outside ploop: 0, in/with ploop: 0, no ploop: 12

Total directive loops: 30, effective: 30, in ploop: 0

The last line of the statistics indicates how many loops can be put with directives, how many of them

are really added with directives, and how many of them are nested inside other loops with directives.

Next is to construct parallel regions based on the loop information. A parallel region includes at least

one parallel loop or pipeline loop with possible basic blocks in the beginning of the loop. No nested
parallel loops are considered at this point. Two neighboring regions can be joined together if no codes

other than comments or nops (such as continue) exist between the two regions. Individual regions
are labeled sequentially within a routine. For each region a number is included in 0 to indicate the end

(or last) region of a joined area of regions. For disjointed regions, the end region is the same as the
region itself. Additional information included for a region are: loops in the region and type of the

region. Regions are also summarized for a routine as "region-type-summary".
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Region-type:

one ploop

+prey-block

sub ploop

pipeline

<default>

-- containing exactly one parallel loop (no pipeline)

-- one parallel loop plus any preceded basic blocks

-- one or more parallel loops nested at different levels

-- potential pipeline

-- region with joined, neighbors

Reg i on- type - summary :

DEFAULT -- routine contains normal parallel regions

PIPE --routine is part of a pipeline region

UPI PE --routine contains potential pipeline regions

Sample outputs from the analysis of NPB-LU:

Region-in-Routine: BUTS

region-type-summary: UPIPE

Parallel region 1 (2): loops

Parallel region 2 (2): loops

*** Total number of regions:

Region-in-Routine: JACU

region-type-summary: DEFAULT

Parallel region 1 (I): loops

*** Total number of regions:

Region-in-Routine: SSOR

region-type-summary: DEFAULT

Parallel region 1 (I): loops

Parallel region 2 (2): loops

*** Total number of regions:

[1-31

[4-7]

2, joined regions:

[1-2] one ploop

I, joined regions: 1

[4-7] one ploop

[10-13] one ploop

2, joined regions:

Once the initial regions are determined, routines are then checked for possible pipeline regions across
routines. If such a region is identified, the pipeline-loop limit is checked against all other parallel loops

in the same pipeline region for alignment. If a discrepancy is found, a message will be printed out as

either "not the same limit" or "low-high limit swapped!". In the first case, the suggested pipeline

operation may produce incorrect run-time result and further check of this generated code is needed. In
the second case CAPO automatically swaps the loop limit to ensure the consistence. If pipeline loops
are not desirable, set the environment variable CAPO REGION to "j oin".

For LU, routines BUTS and JACU were identified to be part of a pipeline region in routine SSOR and
information was generated as follows.

Region-in-Routine: BUTS

region-type-summary: PIPE

pipeloop: DO J=JEND,JST,-I (BUTS)

thisloop: DO J=JEND,JST,-I (BUTS)

same limit

Region-in-Routine: JACU

region-type-summary: PIPE

pipeloop: DO J=JEND,JST,-I (BUTS)

thisloop: DO J=JST,JEND,I (JACU)

low-high limit swapped!

Region-in-Routine: SSOR

region-type-summary: DEFAULT

Parallel region 1 (i): loops [4-7] one ploop
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Parallel region 2 (2): loops [8-8] pipeline

Parallel region 3 (3): loops [9-9] pipeline

Parallel region 4 (4): loops [10-13] one ploop

*** Total number of regions: 4, joined regions:

>>>> Grand total: routines 25, regions 34, joined regions 26

Parallel regions are further optimized for removal of end-of-loop synchronization (use the 'NOWAIT'

COnstruct). Although more conservative approach is taken, careful examination of NOWAIT is still
needed. For example, one should pay attention to the WARNING messages on 'EndLoop-Sync

required/reenforced'. If any problem occurs, one can always switch the optimization off (setenv

CAPO_OPTIMI ZE off).

For LU, this is the summary after region optimization:

>>>> Total number of syncs removed: 7, in 4 routines (13 checked)

2.3. Insertion of Directives in Routines

There are four functions performed in this stage:

• clearing any old directives if CAPO_DIRCLEAR is not off (Section 1.3),

• searching for threadprivate common blocks and inserting the THREADPRIVATE directive if

CAPO_TPRIV is not off,

• duplicating routines if needed, and

• insertingregion/loop-level directives.

Information resulted from these four actions are not fed back to the Directives Browser except for

presented as directives in the source code. Thus, once directives are inserted, the Directives Browser

shotdd not be used to do further changes.

A threadprivate common block is the one that have all its variables used as private (including copyin)

for all the parallel regions in the whole program. It means even a single instance of a non-private usage
of a variable can prevent the common block from becoming threadprivate. In the debug mode, causes of

a common block being determined as threadprivate or shared can be examined. See Section 2.4 for
details. Normally messages are printed for identified threadprivate common blocks and routines that

contain them. An example is given here.

T_PRIV common blocks:

-/WORK ID/-18: SP SET_CONSTANTS EXACT_RHS INITIALIZE ADI TXINVR X_SOLVE

NINVR Y_SOLVE PINVR Z_SOLVE LHSINIT TZETAR ADD VERIFY ERROR_NORM

COMPUTE_RHS RHS_NORM

-/WORK_LHS/-18: SP SET_CONSTANTS EXACT_RHS INITIALIZE ADI TXINVR X_SOLVE

NINVR Y_SOLVE PINVR Z_SOLVE LHSINIT TZETAR ADD VERIFY ERROR_NORM

COMPUTE_RHS RHS_NORM

>>> THREADPRIVATE directive added for 2 common blocks in 18 routines

Warmngsmay beprinted _rthosecommon blocksthatpotentiallybethreadprivate:

WARNING! SSOR... region 4, loop 8
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.'CJAC/ Type conflict: old SHARED. new PRIV - use SHARED

It indicates that in routine SSOR all variables in common block/CJAC / are tused as private in region 4,

but the common block is shared in other places. One can trace further for where the common block is

shared in the debug mode.

Directives are added by annotating the call graph and using the parallel region information obtained in

2.2. The call paths are printed as the insertion is progressing. Any routine is only visited one time.

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

Routine:

APPLU

APPLU->SETCOEFF

APPLU

APPLU->SETBV

APPLU

APPLU->SETIV

APPLU

APPLU->ERHS

APPLU

APPLU->SSOR

APPLU->SSOR->KHS

APPLU->SSOR->RHS->TIMER_START

APPLU->SSOR->RHS->TIMER_START->ELAPSED_TIME

APPLU->SSOR->RHS->TIMER_START->ELAPSED_TIME->WTIME

APPLU->SSOR->RHS->TIMER_START->ELAPSED_TIME

APPLU->SSOR->RHS->TIMERSTART

APPLU->SSOR->RHS

APPLU->SSOR->RHS->TIMER_STOP

APPLU->SSOR->RHS

APPLU->SSOR

Routine: APPLU->SSOR->L2NORM

INFO! Array reduction variable replaced with local critical in region 1

SUM() --> SUM_CAP1()

Routine:

Routine:

Routine:

Routine:

Routine:

WARNING!

ELAPSED

Routine:

Routine:

Routine:

Routine:

WARNING_

ELAPSED

Routine: APPLU

Routine: APPLU->ERROR

INFO! Array reduction variable replaced with local critical

ERRNM() --> ERRNM_CAPI()

Routine: APPLU

Routine: APPLU->PINTGR

Routine: APPLU

Routine: APPLU->VERIFY

Routine: APPLU

APPLU->SSOR

APPLU->SSOR->JACLD

APPLU->SSOR

APPLU->SSOR->BLTS

APPLU->SSOR

Potential memory conflict for shared variable in region <2,1> -

APPLU->SSOR->JACU

APPLU->SSOR

APPLU->SSOR->BUTS

APPLU->SSOR

Potential memory conflict for shared variable in region <3,1> -

in region 1 -
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WARNLNGs for "...variable used after a parallel region", "potential memory conflict", and INFOs on the
changes made to routine arguments should be examined carehJllv. These are just warnings, may or

may not cause any programming errors. The warnings are the cases where CAPO are uncertain of

decision making and user needs to inspect the generated code at the pointed places for verification. The

parallel region is labeled as <region_number, parallel_loop_number> pairs in the call path

right preceding the warning message.

Meanings of keywords in the WARNING message:

"variable" -- a variable used in the current routine scope

"common-variable" -- a variable used outside the current scope, e.g. through COMMON
blocks or SAVE statements in a subroutine

"Shared" -- variable shared in the current region

"Plocal" -- potential private variable in the current region

"Control" -- variable with multiple control paths, i.e. variable could be updated

either inside or outside the current region

"I/O statement" -- routine called inside a parallel region contains i/o
(OPEN,READ,WRFFE,C LOSE) statements

"STOP statement" -- routine called inside a parallel region contains STOP/PAUSE
statements

"Potential memory conflict"--for shared variable that can cause memory conflict in a parallel

region

If a private variable in a parallel region is updated via a COMMON block in a subroutine, CAPO tries to

privatize such a variable by adding it to the subroutine's argument list and renaming the original

variable in the COMMON block of the subroutine. CAPO will generate the following INFO messages
in this process:

New argument () added to CALL OTHER_ROUTINE () :# in ROUTINE_NAME

New symbol () added to the argument list of ROUTINE_NAME

Common block /cblk/ duplicated for ROUTINE_NAME

CAPO performs a code transformation automatically for a reduction variable that is an array element.
The corresponding message is like:

Array reduction variable replaced with scalar in region # -

OLD_ARRAY_ELEMENT --> NEWSCALAR_VARIABLE

2.4. Debug Information

More information will be logged if CAPO_LOGINFO is set to "debug". These are useful for debugging
CAPO. Some of the information are included here for reference only.

• UserLoop information for user-defined loop types

Userloop: Defined loop # in routine ROUTINENAME - newtype

"newtype" is one of (S, P, R, B) as mentioned in Section 1.3.

• List of old directives to be cleared

• Summary of loop type with list of all dependence vector deltas for pipeline loops
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• Three tests during region formation

Mem-Conflic_ check for region #R, loops _L-#L...
Conflict variables: <var,var...>

Shared-Array check for region #R, loops #L-#L...Assigned <Symbol>

IO-Statement check for region #R, loops #L-#L...
I/O or Reduction in routine <RoutineName>

• List of symbol and types in each region

TYPE

Private

Reduction

ArrayReduction

Shared

LastPrivate

FirstPrivate

CopyInOut

ThreadPrivate

UnknownType

CONTROL

No-Control

Control-Dep

SCOPE

In-Scope

Not-in-Scope

Not-in-Use

-- Local (privatizable) variable
-- Scalar reduction variable

-- Array reduction variable
-- Shared variable

-- Usage in and after the region

-- Usage in and before the region

-- Shared but no or no proof of loop-variable dependence

--Used in a threadprivate common block

-- Type not defined yet

-- Symbol not in a control dependence

--Symbol in a control dependence

-- Symbol defined in the current routine

-- Symbol not defined in the current routine (defined via
common block or save statement)

-- Symbol passed into a subroutine but not used in the
subroutine

DTYPE : DEPTH (printed in [. :. ] )

Io -1, Input/Output
NT 0, Non-exact True

NA 1, Non-exact Anti

NO 2, Non-exact Output
ET 3, Exact True

EA 4, Exact Anti

EO 5, Exact Output
CT 6, Control

UN 7, Unknown type

Depth = 0 for loop-independent dependence

List of

regions/loops.

bitl [0x01]

bit2 [0x02]

bit3 [0x04]

bit4 [0x08]

bit5 [0x!0]

routine call types, indicating the usage of a routine
Five bits are used:

called outside parallel region

called inside paregion but outside parallel loop
called inside parallel loop

called outside parallel loop (= bit1 } bit/)

called inside parallel region

inside/outside parallel
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In_rmation onupdating duplicatedroutmes

Replace call to DROUTINE with CAP_DROUTINE in ROUTINE

Removed ROUTINE from the calledby list of DROUTINE

Added ROUTINE to the calledby list of CAP_DROUTINE

List of symbols and affine expressions for tes_ng loop limits (such as in the removal of end-oG

loop synchromzations)

HOME (LOOP-VAR-EXPR, #hits) Low <EXPR> High <EXPR> [AI:INDX,A2:INDX..]

(LOOP-VAR-EXPR, #hits) Low <EXPR> High <EXPR> [BI:INDX,B2:INDX..]

OTHER (NONLOOP-EXPR, #hits) [CI:INDX,C2:INDX..]

(NONLOOP-EXPR, #hits) [DI:INDX,D2:INDX..]

Here <EXPR>isasymbolicexpression, A,B,C,D areaway names, INDX _therelevantarray

index. The lists are for both source and sink.

Summary of fields associated with the ploopinfo data struct, mainly for development purpose.

Loop Lvar D/L Type G WP IP Nest Flag

Routine: ROUTINE_NAME

# var ?/? TYPE? ? ? ? n/cn [321]

'Loop'

'Lvar'

'm'

'n'

'Type'

'S'

'WP'

'IP'

'n'

'cn'

'Flag'

-- the loop number in a routine

-- the loop variable name
-- the 'dlevel' value

-- the 'level' value of the loop

-- one of type strings given in Section 2.1

-- the loop granularity flag (internal info only)

--'1' containing parallel loop, '0' without parallel loop

--'1' inside parallel loop, '0' not inside parallel loop

-- this loop nest flag (containing nested parallel loop)

-- child loop nest flag (part of nested parallel loops)

-- three bits for internal usage only

Symbols and thek types in common blocks (_r t_tmg threadprivate). Meanings of symbol

types:

[U] --Unset

[P] -- Private

[R] -- Reduction

[A] -- ArrayReduction

[S] -- Shared (RW)

[s] -- Shared (Readonly)

[L] -- LastPrivate

[F] -- FirstPrivate

[C] -- CopylnOut

• Methodsusedin determiningthedeclarationsizeofunknown-sizevariables

[NOT ]IDENTICAL SIZE, method i (caller declaration) used

MAX(el .... ), MIN(el .... ), method 213 (access range in routine) used

NO method - variable NOT safe - <var>
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3. CAPO Graphic User Interface

CAPO is currently integrated into CAPTOOls as a component to generate OpenMP directives. For
CAPO-enabled CAPToots, additional items have been added to the File, View and Edit menus (see

Section 3.10) to access the CAPO graphic user interface (GUI).

The CAPO GUI is also referred to as the Directives Browser. It provides an easy way for user to access

information generated during the directives analysis and insertion. The browser consists of several
information windows and dialog boxes as given in the following sections. It also provides hookups to

the CAPTools' GUI tools, such as DepGraph, Variable Browser, etc., so that one can easily navigate and
interact with the parallelization process.

3.1. Directives Browser Main Window

Scope: 26 RouHne_;:

I All Routines

Loop Flite_ Sub:

i Totally Serial : All _e!_t_

Covered Serial ) True Recursion i 3.,;i,._,_.n

Falsely Serial I/0 or Exit i _l:_._c,_ ":_e
....... _ ........... _ e;h')

Reductions i NO Cranularity q........................... : _d rr._:

Pipeline User Defined '

Chosen _la

4 Totally serial loops (i.e. not within or containing parallel loops):

• i l_l_,:znns: do_-z._.l ','i
, ) buts:I/I/3S: do n-l, np, l

• i

: ssor:12/2/231: do ].-Lst, Le_l, 1
ssoc :13/2/253: do l-Lend. 1st, -1

, i
: i
!

+_j

Update Directives... "_ Setting... }

User Loop: Dismiss ' Hemp... )

The main window of the Directives browser is activated by View->Directives... from the CAPTools
main window (see Section 3.9) after a source or database is loaded in. It presents information from the

first two phases of the directives analysis (before directives are added). It is organized around loop
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types and is an entry point for other browser windows, such as WhyDirectives and
RoutineDuplication.

Once directives are generated (via Save OpenMP Directives Code), the Directives browser should not be

used to do further changes.

Scope [setting]: selects one routine or all routines for loop listing.

Routines [list]: a list of routines that can be selected for loop listing.

Loops [list]: a list of1o_9_ under the selected routine/loop filters. To activate the WhyDirectives
window through the [Why...] button, a loop needs to be selected.

Loop Filter [list]: provides a way to focus on a particular type of loops, mainly serial or parallel, as
described in details in Section 3.2.

Sub [list]: sub-loop filter to be combined with the loop filter to provide finer control of loop selection.

More Filter [button]: activates the Loop Variable Filter window to perform even finer loop selection

(Section 3.2.1).

Show Parallel I/O [setting]: controls the way that a loop with I/O statements inside is displayed. By

default (Yes), loops with potential parallel I/O are classified as parallel although parallel I/O with

directives is not supported at this point.

RoutDup [button]: activates the RoutineDuplication window (Section 3.4).

Why [button]: activates the WhyDirectives window (Section 3.3) after a loop is selected.

Update Directives [button]: activates the Update dialog box (Section 3.5) to re-perform the directives

analysis, usually after settings are changed.

Setting [button]: activates the Setting window (Section 3.6) to reset parameters for CAPO. The window

may also be launched from Edit->Directfves Setting... in the CAPTools main window.

Current Routine [textpane]: displays the source of a selected routine or a routine in which a selected

loop is located. The selected loop nest is highlighted.

How a loop or a statement is labeled:

RLH$:l]I/83: DO 100 L=LS,LE,1

Loop:/ \__

routine loop nesting line
name number level number

Statement: P£lis :110 :CALLRLHSL(N(Yrl, JPLrR,J5

/ \
routine line

name number
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3.2. Loop Filters and Sub-filters

Definitions of basic loop types:

Serial loop -- a loop with loop-carried TRUE dependence from data flow, ANTI/OUTPUT

dependence from non-privatizable variables, I/O statements, and/or exit statements.

Parallel loop -- a loop without loop-carried TRUE dependence from data flow, ANTI/OUTPUT
dependence from non-privatizable variables, I/O statements, and exit statements. Such a loop

can be executed in parallel.

Reduction loop -- a loop, other than one or more reduction operations, that can be executed in

parallel.

Pipeline loop -- a loop that contains loop-carried TRUE dependences with determinable, non-

negative dependence vectors. The loop can potentially be used to set up a parallel pipeline

with an outer loop.

Distributed loop -- one of Parallel loop, Reduction loop or Pipeline loop.

Loop Filter:. Sub:

I Seria, [A,,
I

CoveredSerial

FalselySerial

Reductions

Pipeline

Chosen

NotChosen

True Recursion

I/O orExit

NoGranularity ]
UserDefined

Loop Filter:. Totally Serial --
serial loop with 10op-carried TRUE dependence, containing no

i distributed loop and not nested inside other distributed loop. Thecode section in the loop will be executed sequentially.

Sub-filter: True Recursion -- no I/O or exit statements
i I/0 or Exit -- with I/O and/or exit statementst

No Granularity -- one or no iteration

User Defined -- user-defined serial loop "S"

Loop Filter:.

Totally Serial

i CoveredSerial

FalselySerial

Reductions

Pipeline

Chosen

Not Chosen

Sub:
F

-
True Recursioni

I/O or Exit I

]Inside Parallel

User Defined

Loop Filter:. Covered Serial --

serial loop with loop-carried TRUE dependence, containing
distributed loop or nested inside other distributed loop. The code

section in the loop will partially or completely be executed in parallel.

Sub-filter: True Recursion -- no ]/O or exit statements
I/O or Exit -- with I/O and/or exit statements

Inside Parallel -- inside other parallel loops

User Defined -- user-defined serial loop "S"
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Loop Filter:.

Totally Serial

Covered Serial _,

i Falsely Serial

Reductions

Pipeline

Chosen

Not Chosen

Sub:

; All

Privatization

I/0 Statement

No Granularity

User Defined

Loop Filter:.

Totally Serial

Covered Serial

Falsely Serial

I Reductions

Pipeline

Chosen i
Not Chosen !

Sub:

[A" : : • -

,.,

°..

User Defined

Loop Filter: Falsely Serial

serial loop without loop-carried TRUE dependence, but containing

ANTI/OUTPUT dependence from non-privatizable variables. Loop

may contain distributed loops for parallel execution.

Sub-filter: Privatization -- due to non-privatizable variables
I/O Statement _ with I/O statements but no nested

parallel loops

No Granularity -- no granularity and no nested parallel

loops

User Defined _ user-defined serial loop "S"

Loop Filter:. Reductions

loop with one or more reduction operations which can be executed as

parallel reductions.

Loop Filter:. Pipeline-

A pipeline loop as part of a parallel pipeline working with an outer

loop.

Sub-filter: All -- all loops with reductions/pipeline

User Defined -- user-defined reduction loop "R"

Loop Filter:.

Totally Serial

Covered Serial

Falsely Serial

Reductions

Pipeline

I Chosen

Not Chosen

Sub:

t Copyln/Out
Ordered

I
i User Defined
I

Loop Filter:. Chosen (Parallel) --

parallel loop chosen for distribution with directives. The code section

! in the loop will be executed in parallel.
J

l Sub-filter: Normal -- regular parallel loop

tt CopyIn/Out -- with copyin/copyout variables

I Ordered _ with ordered code section
2

User Defined -- user-defined parallel loop "P"

Loop Rlter:

Totally Serial

Covered Serial

Falsely Serial

Reductions

Pipeline

Chosen

. Not Chosen

Sub:

t All . . :

Inside Parallel

I/0 Statement

No Cranularity

User Defined

Loop Filter:. Not Chosen (Parallel) --

parallel loop not chosen due to other parallel loop(s) already been

chosen. The loop is either inside other distributed loop or contains

distributed loops.

Sub-filter: Inside Parallel -- inside other parallel loops

I/O Statement _ with I/O statements

No Granularity -- parallel but no granularity

User Defined -- user-defined parallel loop "P"
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3.2.1. Loop Variable Filter Window

The Loop Variable Filter Window controls even finer selection of loops in conjunction with the main

loop filter and sub filter. The filter applys to variables used in loop heads.

Routine [label]: indicates the cturrently selected routine.

Variable List [list]: contains a list of variables used in the loop heads of the current routine.

Scope [setting]: controls the scope of variables.

Loop Variable

Loop Limit
Either

-- variables from loop iteration

-- variables from loop high-low limit
-- either of the above two cases

Choice [setting]: controls the filtering effect.

Inclusion

Exclusion
-- show loops when variables appear

show loops when variables do not appear

Vtu;lable LIs¢: ' - ""' Routine: =soz" •

:;ie_'" " " " Scope: Choice:

J=i=2
Loop Limit Exclusion ]}

jst_ -" Viu'lible(s):

_'Reset _ Apply ) O sm ss _ Help... )

Filter [setting]: disables or enables the loop
variable filter.

Variable(s) [textfield]: contains a list of the

currently filtered variables.

Add [button]: adds the selected variables in the
Variable List to the filtered variable list.

Reset [button]: resets variable selection.

Apply [button]: applies the current filter to the
display.
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3.3. WhyDirectives Window

-I " --.. .".......CAPO:Why DlrecIlves? "- ""._...."• J"iJ]

Loop: ssox:: 7f1/204 ; do £sCep-l, £tmax, 1

Type: Covered Serial New Type... _1

Hints:
f

I ConCadns 7 parallel Loops

i 11 variables with loop-carried

true dependencies (level-I)

6 variables with loop-carried

i output dependencies (level-l)
2 IO/F.xit sCaCelents inside

IO/Exlt statements:

210 :wire (UITIT-* i

342: return

I

C

. b
I

sele______AJl)

Contains 7 parallel loops:

Reason: I/O or Exit containin9 parallel loops

True-dep. variables _ Anti-dep. variables
I "[rsdrm

u

rho_i

qs

i_,
ssoc:8/2/219; do k-2,nz-lol t't
ssor:14/2/281: do k-2, z_-1,1

12nora:2/1/2g: do k-2,_0-1, 1

rbs:S/1/176: do k-2, nz-1, 1

zhs:16/I/242: do k-2°nz-l,1

SelectA!lJ

A

I

Output-dep. variables

zho_i

qs

elapsed

Carray

Select All )

Inside parallel loops:

Dismiss ) Help... I

i
The WhyDirectives window is displayed for a selected loop after the _ button is clicked in the
Directives main window. It presents detailed information for the selected loop, in particular, reasons
and hints on why the loop was classified as serial or parallel. The window can be used to remove false
dependences identified by the user and to redefine the loop type. Depending on the current loop type,
the three variable lists may show different types of variables and the two loop lists may present
different information. The displayed window is for Co_ered Serial.

The following items are common for A|l Loop TvDes.

Loop [textfield]: currently selected loop with routine name and loop labels (see the end of Section 3.2).

Type [textfield]: loop type as described in Section 3.1.

Reason [textfield]: one sentence summarizing why the loop was classified to its type.

Hints [textarea]: more detailed sLuTtmary of the usage of the relevant variables in the loop and whether
the loop contains I/O statements, exit statements, etc.

New Type [button]: activates the New Loop Type dialog box (Section 3.6).

Select All [button]: selects all variables in the corresponding variable list.

Reset [button]: deselects all variables in the variable lists.

Remove [button]: activates the Variable Removal dialog box (Section 3.8) for the selected variables.
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lO/Exit statements [lLst]: list of I O and eMt statements in the selected loop nest.

The following list is common for Totally Serial and Covered Serial.

True-dep. variables [list]: list of variables causing loop-carried TRUE dependences, removable. An "[x]"

followed a variable indicates the dependence vector length for this variable.

The following lists are common for Totally Serial, Covered Serial and Falsely Serial.

Anti-dep. variables [list]: list of variables causing loop-carried ANTI dependences and the variables
cannot be privatized, removable.

Output-dep. variables [list]: list of variables causing loop-carried OUTPUT dependences and the
variables cannot be privatized, removable.

Contains parallel loops [list]: list of parallel loops that are nested inside the current loop.

Inside parallel loops [list]: list of parallel loops that contain the current loop•

The following list is for Falsely Serial.

In]out-dep. variables [list]: list of variables that have data (TRUE) dependences from the outside of the
loop, removable.

Loop: _iacld:l/1/1GO: do n-l,_p, 1 Reason: anti/output dependencies, variable not privatizable

Type: Falsely Serial _.' New Type... ) Anti-dep. variables

Hints: :

4 vaziable, .ith loop-carried j_

output dependencies (level=l)

, _d non-privatizab!e, due to

I usage fro_ out_id= t_m loop4 out_out-dep (>) variables

I O/F.xit statements:

T
f
!
i
t

i"
i

i

sele_ All ) Select All )

Res__ " Remwe..)L b, co d

Output-dep.variables In/out-dep. variables

7 ":- ,b -

_d "' ":_ , " - >a

Inside parallel loops:Contains parallel loops:
Dismis__._._ss) ._

_._.J

"i

The above window is for a F,71selySerial loop.
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The following lists are common for Reductions, Pipeline, Chosen, and Not Chosen.

Private variables [list]: list of privatizable variables in the loop nest, not removable.

Shared variables [list]: list of shared variables in the loop nest, not removable.

Nested parallel loops [list]: list of secondary parallel loops that are nested inside the cttrrent loop.

Inside parallel loops [list]: list of parallel loops that contain the current loop (except for Pipeline).

The following list is only for Reduction Loop.

Reduction variables [list]: list of variables for reductions in the loop nest, not removable. Reduction

variables are preceded with labels indicating reduction operators or intrinsic functions. A "0" after a

variable indicates an array reduction.

Loop: 12no_'J=:2/1/_29: do k-2, r_0-1.1

Type: Reductions

Hints:

Loop rich 1 reductions

4 privaCe v_iables
6 shared _risbles

IO/Ex_t state me nts:

' lii

t

New Type... )

_.J

...J

Reason: Loop involving reductions

Private variables Shared variables
[--J

!
il v

i ist

j lend
k jst

I jend

nzO

Reduction variables

I--J

•:suaO , :
i-J

Select All ) Select All ) Select All]

Reset _ Rerncvs... "_

Nested parallel loop:

12nori:3/2/30: do j-jst, jencL1

Inside parallel loops:

Dismiss ) Help... j

The above window is for a Reduction loop with reduction array variable "sum ( )"
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The following lists are only for Pipeline Loop.

Inside parent loops [list]: list of loops that are nested above the current pipeline loop to form parallel
pipelines. Appropriate swlchronization directives and statements will be inserted at the code

generation. A parent loop is usually a serial loop without I/O and exit statement inside.

Other variables [list]: list of variables other than private and shared, such as Copyln/CopyOut
variables, not removeable.

___]_" f_,'_fl_-_;';' " _ : _,_:_CAPO: Wh_/Directives ? ; - . :_ ' t ' t_Jt

Reason: Loop as part of pipelines

Private variables Shared variables

Loop: b].ts:4/1/43: do j-jst, jencL1

Type: Pipe!!ne New Type.. )

Pipel.iat loop

. 6 pri,xa_ waciables

!z =hazed nZ_i_Z.e=

IO/Exit state me nt_,

i '! i4

t=mt
I

J

!
Select All

._j ................... /

Nested parallel loops:

d

ldx

lay
V

tw

k

o_e(ja

i,,t

Other varlab les
J

,1

Jl.

Select All ) Select All )

!
Dismiss ) Help..

Inside 1 parent loop:

il i=_o_ie _/2/21.3Lj'do k;2,_-1,1 _._ 4.;.::, J'

; t_J

The above window is for a Pipeline loop with the parent loop highlighted.

The following lists are only for Chosen Parallel Loop.

Copyirdout variables [list]: list of variables that will be declared as Copyln (FIRSTPRIVATE) and/or

CopyOut (LASTPRIVATE) due to potential conflict in updating the same memory location and the
variable(s) having usage outside of the loop. It might arise, for example, from an induction variable that

is assigned before the loop and used after the loop• It could also indicate a programming bug.

Controlled variables [list]: list of variables that will be placed inside an "ORDERED" code section. These

variables are usually inside TF conditional statements and the corresponding assignments need to be
executed in a designated order as is in sequential.
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CAPO:Why Directives? - i •!JJl
Reason: Parallel loop exploited with (opyin/out variables

Private variables Shared variables Copyin/out variables

Loop: BCCTJK:2/1/99:D0 300 N-I, IIQ, I

Type: Chosen . New Type...,)

Hints:

ParaLlel loop

._JiJ
12 priv_t_ variables

18 shared variables

I copyout (>) variables

j_
I

J
I

/M

3P

LM

LP

ISM00

L

DJJP

DJJ

5elect All )

P.÷;fl._¥e.., "l

i--J
ab

r
i

IBLANK

SKO0

,]PER

10NE

LPER

NSMO0

LD

JO

i

._J

Select All

_,J

!

Dismis.__._._._s) _l
IO/Exit state me nts: Nested parallel loops:

BCCTJE:3/2/106: DO 30 3-,1S,,TE, 1

BCCTJE:3/2/116: DO 40 L-LS.LE, l

ZERO: 1/1_/10 : DO 10 I-1, LEN, 1

BCCT/K:8/3/129: DO 110 L-LS, LE, 1

]_CCT3K:10/3/145: DO 120 3-3S, Jm, 1

BCCT,tit,:12/3/161: DO 130 L-LS, LE, 1

_.J

++!

Inside parallel loops:

I
The above windows is for Chosen parallel loop with Copyin/out variables.

-I+,

Loop: STMCHK:7/1/179: DO L=I,LD, 1

Type: Chosen New Type... )

Hints:

Reason: Parallel loop exploited with ordered assienments

Private variables ShaPed variables ontrolled variables

Nested parallel

£RR

__ SKEW

'_ DZ

D7

ITIOL

DX2

DX1

DX

i

Select All )

Reset _. _*rr_.:_s... ':

loop:

Para]J.e]. loop

10 p_xva_e variab].es

9 shared variables

1 other v'aJ:iablee

....J

"i

I

I O/Exit state me nts:

_C_:8/2/180: DO 3-1,3D, 1

i--
_A Z

TOL

KP

K_

x

K

_D

Select All )

] "_ tmmo.l

_J

Select All )

t--

!_
!"

.'J

I
+4 I

Inside parallel loops:

Dismiss ) Help..,)

__J

+5

The above window is for Chosen parallel loop with Controlled variables.
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3.4. Routine Duplication Browser

LI=

P2J

P2X

Vl'I_I

Orig. Routines: Dup. Routines:
._J !

i _ LZJ 1

_lP' "P2J "1

; c_ajn__l

I-

Number of Duplicated Routines: 24

CAP_. Directives RoutlneDup Browser i.

2 Calls Inside I_mllel I_op:

[mJ_ 131; cJ_J. _ 0_ ;me. as

Inside Loop: RTJLS:3/1/126: DO 300 L-LS, L[,1

Inside Cull In Routine: NJIS

zz7 :c ITI
118 : ELSE [ I I
zl9 :c I | I
120 :C Loop _ou_ JK-pl_es I I ]
z21 _c I I I
122 : Rl"XP2-P.2D'14 I I I
123 _SONP PARALLEL D0 DrFA'JLT(SHAP...L_) PRZVATE(TI, IP2...".'.'.'.'.'.'.'Z_2.L)t]l
124 :!S0l_& SHARED(KSRC. LPER. F21[R. LD. KD. JD. CI_.TI_.CTOS0. RL_
• 3PER. NO'ft. JSP,C, I I I

x_ : ,so.PaKZ.KS•JZ.Os.rr_2, LZ.LS) I ; I
z26 : Do 300 L-LS, LZ.I [il
127 : CALL GL-EP_X(NT_2. TI_2. ITtQ2) .
128 :c III
129 :C J-dzrectzon I I I
z3o :c I I I
13z : CALL_.Sa (._, aP_.aS,am._, KS,rE.LP[_.L.I I I
BKY. Tr0S0. CrL_. asac. 0.voaJo_. Or. s. TSCAL. VWOL. V_T. Dt_ml. nAI [ I
u_2. WALL. vo_¢. _s. _v. ZB_X. _2 (Z_2.1), _2 (_nm2.2).1 ] ]
_R>2 (ITI_2.3). TKP2 (IT_OP2.4).VOL. XX. X_. xz. YX. W. YZ. ZX. Z¥. 2Z. ]q ,_1
T. 'I"1"•_'. '1"I(I>2(ZTICP2, 5), ,70. I_. LD) i|]
132 :C l---i!
133 :C K-dx rec'_zon l_l

13S : CH_ RLHSlC()Krl'r, JI_EK_S, JZ,lr,pzKXS, lr,E.Lpr_,L,I I
m_r. Tree0, CrLC_B. _SRC, o vot_. ¢L s, TSCAL. V_.. Vi_T, O_l, O_._[

Outside Cull In Routine: I)OBCL_

305
306
307
3O8
309
310
31!
312
313
314
315
316
317
318

320
321
322
323
324
32S
326
32T
328
329

3 Calls Outside Parallel Loop:

Im:.3_;cau_ w (a.sLa_r_,: J
=J

Dismiss _ Help_ )

:C -_I$0MP PM_LZJ_ DO DEr/_ULT(S'rL_CZD) PRI_ATE(3,K)
: !$O)_& S_M_(D (3S, JE, F_, K£)
: D0 220 K-K$,KZ, 1 ! ,

: DO 220 ,-JS. JE. 1 t iC (J, _,) -I
: A(3. K)--B (a. K) i '

220 CONTIN1R
:_SO)a:>_ PA,RALL£L DO

c co_ !
:C Solve peezodzc or nor_peczodzc r,z:zdzacj'onaL system, i
:C

zr (_ez_) _ i '

ELSE [

C_LL _rRI (JS. dE, KS. r_, A. C. B, R]i$. 3D, Y_) _.
ENDIF !

c _zr
C Update boundarzes for 9zven Lopoloc]y i"

:C {
C J-dlEoctlo_ I

c zr (_,e_)

The RoutineDuplication window is used for browsing routines that are to be or were duplicated to

avoid usage conflict of directives. The window is activated from the [RoutDup... I button in the
Directives browser main window.

Orig. Routines [list]: list of original routines to be duplicated.

Dup. Routines [list]: list of duplicated routines. Before code generation, this list will be empty. After

code generation, the list is filled with new routines that have one-to-one correspondence to the original

routines. The matched (original, duplicated) routine pairs are selected in concert.

Number of Duplicated Routines [numeric]: as it says.

Calls Inside Parallel Loop [list]: list of call statements (to a selected original routine) that are inside

parallel loop(s).

Calls Outside Parallel Loop [ltst]: list of call statements (to a selected duplicated routine) that are

outside any parallel loop.

Inside Loop [textfield]: the loop that contains the selected call statement to an original routine.

Inside Call in Routine [textpane]: the source for the corresponding loop for Inside Loop. The textpane

is also used for displaying source code for the selected original routine.
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Outside Call in Routine [textpane]: the source arotmd the selected call statement from the Call Outside
Parallel Loop list. The textpane is also used for displaying source code for the selected duplicated
routine.

3.5. Parameter Setting Window

A default setup for the Parameter Setting window is displayed on the left. It is launched from either the

ISetting ..-j button in the Directives main window or the Edit _ Directives Setting... in CAPTools main

window. The window is used to reset parameters for CAPO to control the directives analysis and

generation. The available parameters and their values are described in Section 1.

CAPO Version: ,.:_; Lol Information: _ Standard
1.1.01

Date Built i Directive Type: _ OpenHP

30-Jan-01 Region Type: _ Full (+Pipeline)

Loop Granularity:. 6, [_jvJ

Optimization: rl 02

Routine Duplication: _J RegionUsage

Generate NOWAIT

_( Handle Array Reduction

_" Apply UserLoop Type

._J Use f77 Comment Style

_J Use Partitioned Loop

Others: _" ProcessTHREADPRI_/ATE

_( Transform InductionLoop

_( RemoveOld Directives

"s;tupPipe,hetoop

__J Allow Unknown-Size Array

To update directiveswith new settings,use _> Update )

. Ap____ Dismis_____s) Help,.."_

CAPO Version: the current version

number of CAPO.

Date Built: date on which the

current version of CAPO was built.

Update [button]: re-performs direc-

tives analysis with the current

parameters.

Apply [button]: applies the cttrrent

parameter setting without perfor-

ming the directives analysis.

For detailed information on settings
and checks, see Sections 1.3 and 2.

The following briefly describes

each setting and check box in the
window.

Loop Granularity [numeric]: the
minimum number of iterations in a

loop for the consideration as a

distributed loop. If the number is 0
or if the number of iterations

cannot be evaluated, there will be no check on the granularity for the loop.

_t Standard

[ Minimum;

I Standard

More

Debug

Log Information [setting]:
Minimum -- minimum log information, such as warning and info messages,

Standard -- "Minimum" information plus statistics for loops and regions,
More -- "Standard" information plus more detailed loop and region

information,

Debug -- "More" information plus much more for debugging purpose.

For both More and Debug, loop and region labels are inserted in the generated
source code.
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SGI

SGIxtension

No Directive

Directive Type [setting]:

OpenMP -- generate OpenMPdirectives (default),

SGI -- generate SGI native directives,

SGIxtension-- generate OpenMP directives with SGI extensions,
No Directive-- create source file without directives.

•"_..] Full (+Pipeline)

One Loop Jl

PBIk+ One Loopi
]

One Region

_ 02

o3 I

Region Type [setting]:
One Loop

Pblk + One Loop

One Region

Joined Region

Full Region

-- only one loop for one region,

-- one pre-block plus one loop for one region,
-- regions are not joined,

-- regions are joined, no pipeline consideration,

-- consider joined region and possible pipeline (default).

Optimization [setting]:

Off -- do not do any optimization,

On -- try to reduce synchronization at end-of-loop,

02 -- use logical disprove (slow sometime) for affinity comparison,

03 -- enable additional optimization (such as automatic loop transformation)
before directive insertion.

RegionUsage
t

[L pu.g, lit
F

Routine Duplication [setting]:

Loop Usage -- routine duplicated if it is used both inside and outside parallel

Loops (no nested parallel region),

Region Usage _ routine duplicated if it is used inside a parallel loop and inside

parallel region but outside parallel loop (allow nested parallel region).

Others [checkbox]:
Process THREADPRIVATE

Generate NOWAIT

Transform Induction Loop

Handle Array Reduction
Remove Old Directives

Apply UserLoop Type

Setup Pipeline Loop

Use f77 Comment Style

Allow Unknown-Size Array

Use Partitioned Loop

-- enable/disable the THREADPRIVATE directive

-- enable/disable the NOWAIT directive

-- enable/disable induction loop treatment

-- enable/disable array reduction

-- enable/disable removing old directives

-- enable/disable applying userloop types

-- enable/disable pipeline loop

-- use f77 (not checked) or f90 (checked) comment style

-- enable/disable the use unknown-size array in PRIVATE

-- enable/disable partitioned loop for directives
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3.6. User Loop Type Window

The loop type window is used to redefine a loop type

manually. It is displayed for a selected loop by clicking
on the _,Jew Typ(_ button in the WhyDirectives
window.

Loop [textfield]: print of the selected loop.

Current Type [textfield]: the current loop type.

New Type [setting]: one of the selectable types.

Parallel - a parallel loop

Serial - a serial loop
Reduction - a parallel loop with reductionl The

Reduction setting may activate an additional

dialog box: Reduction Operator (See Section 3.7).
Break - a serial loop excluded from any parallel region

Original - the type originally set by CAPO.

An un-selectable type indicates a type that cannot be converted to from the current type.

-J . CAPS Loop Type

Loop: -9:2/Z/2S8: do i-theft L_st, 1

Current Type: Parallel

New Type:

Parallel ]Serial Reduction I Break t Original !

To update directives with new loop types,

use --> Updatej

Apoly _ ,_

Update [button]: saves the newly defined loop type to the userloop.par file and re-performs the

directives analysis with the new setting.

Apply [button]: saves the newly defined loop type to the userloop, par file but does not re-perform

the.directives analysis.

3.7. Reduction Operator Dialog

This is a dialog box to select an option (or options)

for user-defined reduction loop type. The option
specifies reduction operators/intrinsics and

variables as part of the entry in the userloop.par

file. See Section 1.3 for the description of the
userloop.par file. The dialog box is activated only if

the Reduction setting in the LoopType window is
selected and there exist potential reducible

variables detected in the loop by CAPO.

Loop [textfield]: print of the selected loop.

Variables [list]: list of variables that can potentially
be selected as reduction variables, selectable.

Operator/Intrinsic [setting]: one of the defined

reduction operators or intrinsic functions.

_-;j_:;::-_._,._: CAPO: Reduction Operator _ "_ . ,

Loop: no_e_z3:1/1/2g: do i3-2, n3-1,1

Variables: Operator/Inb'inslc

I .NEQV.
..... L • '

= ° !"IN i

.OR. IOR !

.EQV. IEOR ;!

Select All ) Reset g_(:z_u

Apply i Dismiss _ Help... !

Select All [button]: selects all the variables in the variable list.

Reset [setting]: resets any previous selection. The textfield on the right lists the selected Operator/
Intrinsic and variables.
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Apply [button]: creates an [operator/intrinsic:variables] combination and add to the option list for the

currentlv selected loop. The option and user-loop type are only stored to the userloop par file when the
or _ button in the LoopType window is pushed.

3.8, Updating Directives Dialog

Update Directives with new settin9s ?

This is a dialog box for confirming the analysis of

directives with new settings. It is popped up after the
_"_ button in the Directives browser main window

is pushed.

Update [button]: performs the directives analysis,

including loop and region level analysis, without

generating directives. The dialog will be disabled after
the OpenMP directives code is generated.

3.9. Variable Removal Confirmation Dialog

Really Remove Relevant Dependences
for the Following Variables

Selected Vars: tV. v, v,_v

._A_ly_._ Dismiss ) Help... ) _

The dialog is used for confirming the removal
of dependences for selected variables and

types. The variables and types are determined

in the WhyDirectives window and th_

box is activated by pushing the [Remov_
button. This box provides a shortcut to the
DepGraph for quickly deleting false
dependences.

Selected Vats [textfield]: list of selected

variables from the WhyDirectives window.

Apply [button]: applies the removal action.
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Sco pe:

All RouUrms I

Graph Type:

Call Graph I

Data Flow Parent J

Z-iTT
158
159

160

161

162
163

164
165

166

167
168 :

169

171
172

173
174

175
176

177

28 Routines:

The Data Graph window is used to create graphs for development purpose. It may have little use to a

typical user, but is included for reference. The window is activated from View--,Data Graph in the
CAPTools main window. If the "Data Graph" menu item is not present, try to start CAPO with the [-

capodg] option.

Scope [setting]: defines the scope of the routine list.

Graph Type [setting]: chooses from one of the predefined graph types.

Intrinsics [setting]: excludes or includes intrinsic functions in the routine list and in the graph.

Routines [list]: list of routines (name of the file containing a routine).

Order [setting]: defines the way routines are listed (Alphabetic, Strict, Reversed Strict).

Blocks [list]: list of basic program blocks in the selected routine.

Create [button]: creates a graph for the selected routine and/or block (currently xvcg is used to display

the graph).
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3.11. Hookups to CAPTools

:-'- _-i: _-_%__: ,,-,_._"CAPT_ls_.2,t,Be'ta'-_ p_--Rereas_ (024) ;-:_ _....... +: ._- '-_'_._"_-J -Ji

Vie,.__i.i.i.i.i.i_j _ _ .Analysen..),Par.,!!_.!_!_[.Z; .;en_r_-x... ; PropeRies...) Help.__.__.)

3_ie copy of Ci_Tools is licenced to NASA _es

Licence expires on @ednesday October 31 2001.

Yelcome to Computer bided Parallelisation Tools (CP_OTools) (c)

(c) Copyright 1992-2000 Parallel Software Producte Ltd.

Rights of use

This is a Beta version of CAPTools. You should not transmit or copy this progra_
in any forl to any other company or individual without the consent of the

owners of the code, Your right to use this Beta version of CAPTools ends on

the licence expiry date or with the first release of a coaaercial product, which
ever ie earlier.

Using ChPTools

The user manual provides you with a full introduction to all the concepts used

bY CAPTools and includes several tutorials Use the on-line help to obtain help
zn uszng each window

More information on CAPTools can be obtained from:

Parallel Processing Research Group
University of Greenwich

Queen Anne Bullding

Maritime Greenwich Ca_pus
30 Park Row

Greenwich Tel : +44-20-8331-8731/8655 Web : http://captools.gre, ac.uk

London SEt0 9LS Fax : +44-20-8331-8665 E_ail : captoolsSgre, ac.uk

To report bugs and get user support please email: captool-supportSgre.ac uk

[-_'| ......... _ It] ......... -," ,-t , .... m" ,'1 -r ?Tr ............... I" ................ '_ • .... , -. ........ r_ ..... ..-- - .-.. ....

This is the main GUI window when CArq'ools is started. CAPO is integrated into CAPTools as a
component to generate OpenMP directives. For CAIK)-enabled CAPTools, additional items are added

to the File (Save OpenMP Directives Code), View (Directives) and Edit (Directives Setting) menus.
Those menu items that are relevant to directives generation are summarized here.

(, Load F77 Source,,.

About CAPTools...

Exit

Before source is loaded

S_'--_.P_..all-:l,:c-,_s.-. | Save Parallel Code..

Lc.ad D._tab._,-.s... _ L.'-ad D_tab_._e...

Save Database.,. I Save Database...

_ave V._!us Pr->f;;e C.>d-:... | -_zYe V._;,_8 Pr->flls C-)d÷...

5,:,we ¢Gu...,: ir_s_urr_ted C.',ae...

Save OpenMP Directives Code...

Save Partition Annotation...

Load Knowledge...

About CA PTools...

Exit

After source is loaded

Save AIMS Instrumented Code...

Save OpenM P Directives Code...

Save Partition Annotation...

Load Knowledge..,

About CA PTools...

Exit

After communication is generated
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The File menu: -]

Load F77 Source [entry]: loads Fortran 77 source
(.f or .list file).

Load Database [entry]: loads a previously saved
database (.dbs file).

Save Database [entry]: saves the current analysis
result to a database. As of CAPO version 1.1, the

directives analysis result is not yet saved to the
database. But the inserted directives are saved.

CAPTools: Save DataBase ": :

Directory:. lulwWhjinlcapoltestslnpbllu_ns

_. (Go up a leveD

PI da.dbs

I-_dbs

D lu_parse.dbs

Name: lu_full.db_

La_guaoe: ig_- g'3(, HPF

Source Form: Fi::ed F_e_ :

INCLUDE Path:

The Save Database dialog box.

Save OpenMP Directives Code

[entry]: performs the directives

analysis if it has not been done

and generates OpenMP
directives.

N__£_'-_2.%_?i;CAPTooI_ Save OpenMl_DIrectivegC_le'? _.-:¢.. 7-., :; :_T-J

..CurrantDirectory: /ulw k/hjln/capoltgs ts/n pb/lu_ ns

Dirs: ; Files in Current Directory:.
J ;

I_.(Go up a loved .I ! _-_AIl.listi

' [_1 blts,f
• t!

I I

E_ domain.f

•. ,: Pierhs.f

['_ error.f

_1 exactf

... F_ljacld.f

- _lJacu.f

'._' _:;- '-: _ 12r_orm.f
J

Name: lu_omp,fj

Save Using:

Fllenames ] Suffixed Original Filenames I Single FllenameOriginal
J I

Filen_meSut-fi_ ._mp._

.'"_"v-_ Dismiss _ Help..,

The Save OpenMP Directives Code dialog box.
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Call Graph...

Dep Graph...

Loops...

Args/Com mons,..
Vat Definition..

GlobalVars...

Masks...

Comms...

The View menu:

Directives [entryl:
activates the Directives

browser, which performs

the directives analysis (if
not yet done) and presents
information on directives.

Analyser...
Transformations

Partitioner...
Code Generator...

KnowledgeBase...

READKnowledge...
User Knowledge...

(Directives,.,t ValueProfiler,. I
(Oirecti.sSettin 

The Edit menu:

Directives Setting [entry]:
activates the Setting

dialog box as given in
Section 3.5. It can be used

to set up parameters for
CAPO before the the

directives analysis is

performed.

The following popup menus are hookups to various tools from selected lists or items in a GUI window,

usually activated with a right-mouse-button click.

) t Routine Menu
Command Menu Loop Menu -,I

( Routine Calls... (Routine Calls... )i ( Routine Calls...
Routine Callers...

Partitioner.,.

Transformations

Call Graph,.

Dep Graph...

Loops...

Args/Commons...

Var Definition..

Global Vats...

Nasks...

Comms...

Directives..,

List

Routine Callers,..

Partitioner...

Transformations r-

Call Graph,,.

Dep Graph...

Loops...

Args/Com mons...

Var Definition..

Global Vats.,.

Masks,., t

Comms..,

Directives...

List r- ',

Command Menu [popup]: for a selected statement.

Routine Callers.,.

Partitioner...

Transformations

Call Graph,..

Dep Graph,,.

Loops...

Args/Commons...

Var Definition..

Global Vats...'

I_asks...

Comms...

D irectives...

List

Variable Menu

_ Partitioner...

Transformations r_

Call Graph...

Oep Graph...

Loops,.,

Args/Commons..,

Vat Definition..

Global Vats..,

Masks...

Comms...

Directives.,.

List r,

Loop Menu [popup]: for a selected loop.

Routine Menu [popup]: for a selected routine.

Variable Menu [popup]: for a selected variable.
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4. CAPO Command Interface

The command interface for CAPO is available in Version 1.1 and works closely with the CAPTools'
command interface. It provides a way to access the functionality of GUI components without starting

the components. It serves as a mean to record actions (to a log file) as a result of any user GUI activities

so that these actions can be played back later. The commands in the command interface are usually
recorded to a log file or a command file with

capo -logfile capo_run.cmd

and played back with

capo [-batch] capo_run.cmd.

The command interface for CAPO is different from the command-line version of CAPO, which takes

simply the database as input and creates the Fortran output:

capo -capoc [-options] database.dbs output.f.

This stand-alone version is mostly for testing purpose. The command interface is the preferred method.

4.1. Commands for the Command Interface

CAPO commands start with the keyword "capo" to distinguish them from CAPTools commands.

Maln commands:

load <file.dbs>

- Load database file

capo version 1

- DefineCAPO command version

capo removedep <routine> <variable> <loop_number> <dtype> <fc> [<drout>]

- Remove loop-relateddata dependences
* routine - routinename

* variable - relevantvariableinthe routine

* loop_number - loop tobe considered

* dtype - dependence type: 1 for loop-carried TRUE dependences

2 for TRUE dependences from outside loop

3 for loop-carried ANTI dependences
4 for loop-carried OUTPUT dependences

* fc - 1 father list, 2 child list, 0 both lists

* [drout] - optional field to define routine in which the variable is actually declared (if it
is different from <routine>)

capo update [0/i]

- Perform directivesanalysiswith the new setting

'0' forirdtia]analysis, '1 ' fornew update

capo passtwo

- Re-perform the pass-two analysis

capo generate [<file.f>]
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Generate OpenMP directives. < f i 1 e. f > is used to define the logfile name, i.e. < f i 1 e. 1 og>.

If <file. f> is not given, "capo-info. log" is assumed for the logfile name.

save source <file.f> 3 0

- Save so_wce code to <file. f>

' 3' indicates a single file

("load" and "save" are two CAPTools commands. See 4.2 for details.)

Parameter setting commands:

capo set log-file on/off/stdout

Turn on/off information logging, default ison

capo set log-file-name <filename>

Define log filename, default is "capo-info. log"

capo set log-info minl/std/more/debug

- Select log information type, default is std

capo set loop-granularity <value>

- Set loop granularity threshold, default value = 6

capo set directive-type omp/sgi/sgix/no

- Select directive type, default is omp

capo set optimize-type off/ol/o2/o3

- Set the optimization type, default is 02

capo set user-loop-file <filename>

- Define user loop file,default is "userloop.par"

capo set directive-clear off/on/<filename>

- Turn on/off old directive clearing, default is on

A < f i l ename> is used to define a new set of directives

capo set comment-type f77/f90

- Set the comment type for directive, default is f90

capo set use-parti-loop yes/no

- Allow the partitioned loop for directive,default is no

capo set rdup-type loop/region

- Select the routine duplication type, default is region

capo set allow-pio no/incall/write/noread/any

- Allow parallel I/O type, default is no

Setting commands for debugging purpose:

capo set mflag <mflag_value>

- Define the module flag

<mflag_value> can be <number>/<ml :m2.. > with [+- ] sign

capo set region-type default/loop/bloop/one/join/full

- Set a region type, default is full

capo set tpriv-directive on/off

- Turn on/off the generation of THREADPRIVATE, default is on

capo set allow-unksize true/false

- Allow the use of unknown-size private variables, default is false
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capo

capo

capo

capo

capo

capo

set have-pipeloop true/false

Generate pipelineloop, defaultis true

set have-induc true/false

Treatparallel mductionloop, de_tis true

set have-arreduc true/false

Treata_ayreductio_ de_t_ true

set have-nowait true/false

GeneratetheNOWAIT directive,de_t_ true

set apply-userloop yes/no

Apply user defined loop types, de_t _ yes

set apply-dirclear yes/no

Apply old directiveclearin_ de_t M yes

4.2. Other CAPTools Commands Useful for CAPO

version 2

load

save

save

Define CAFTools command version

<file. f/file, list/file.dbs>

Load source/database file

database <file.dbs>

Save to database

source <dir/suffix/file.f> <1/2/3> 0

Save source with type 1, 2 or 3

Type 1 : Save to original files, <dir> is required for directory name

Type 2 : Save to original files with <suffix>, <dir/suffix> required

Type 3 : Save to a single file with file name <file. f>

set exact on

set scaler on

set knowledge on

set disproofs on

set interprocedural on

set logic on

- Settings _r the analysis power

add read knowledge applu:76:((nx-5

- Define read user knowledge

analyse

- Perform dependence analysis

.GT. 0))

4.3. An Example of"capo_run.cmd"

version 2

load applu_full.dbs

capo version 1

capo set log-file-name applu_omp.log

capo update 0

capo removedep setbv u 1 4 0

capo removedep setbv u 3 4 0

capo removedep setbv u 5 4 0
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capo update 1

capo generate
save source applu omp.f 3 0

To use the command file, do "capo -batch capo run.cmd".
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TUTORIALS

Source codes for all the tutorials described in this manual are included in the CAPO distribution and

can also be obtained from site http://www.nas.nasa.gov/Tools/CAPO/. Refer to "Examples. ¢xt"

included in the examples directory for additional information.

Contents

Tutorial 1. A Simple Jacobi Code T-2

Tutorial 2. NPB LU-hp Removing False Dependences T-3

Tutorial 3. NPB MG User-Defined Loop Type T-7

Tutorial 4. A More Realistic CFD Application T-11

Tutor_a! 5. Mix of Message-Passing and OpenMP T-19
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Tutorial 1. A Simple Jacobi Code

This tutorial demonstrates the very basic operations you would follow to generate an OpenMP code

without little user intervention The code (jacobi.f) has an initialization loop and an iteration loop. The

iteration loop computes new solutions by averaging two neighboring points and checks the maximum
residual.

Steps of parallelization:

, Perform the data dependence analysis. In CAPO, click Load F'/7 Source in the File

menu. Select jacobi.f and click _ In the Analyser window, select the _-_ option and click

_-'_'_. This will just take a few seconds.

, Save to database. In the File menu, click Save database. Enter a filename for the database or

take the default name (jacobi_full.dbs) and click _ It is always a good idea to save the

results from different stages of the code analysis.

, Browse directives. In the View menu, click Directives to perform the directives analysis.
The Directives browser will be popped up quickly. Select the _All Routine_ scope and browse

through all loop filters. You will notice that the Jacobi code contains one Reduction loop (DO 3 0

T=I,R), two Chosen (parallel) loops (DO 10 I=l,R and DO 20 T=2,N-1), and one Falsely
Serial loop (DO 50 I=l, R containing an I/O statement).

1 Produce OpenMP code. In the File menu, click Save _MP Directives Code. Enter a
filename (or take the default name, jacobi_omp.f) and click _Sav_. If the directives analysis has

not been performed (via Step 3), it will automatically b e performed before the parallel code is

generated. The log file, jacobi_omp.log, contains additional information for the parallelization
process.

To compile the OpenMP code on the ,SGI Origin2000, do

% f77 -O jacobi_omp -03 -r8 -mp jacobi_omp.f

To execute the parallel code with 2 threads, do

% setenv OMP_NUM_THREADS 2

% ./jacobi_omp
Enter the values of N and TOL ...

1000 1.0e-6

The output looks like

49.99968169151887

1166848 9.9999888192314756E-07

You can compare the result with a single thread run or a serial version run. You will notice the program

does not scale well, primarily due to little work inside each distributed loop.
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Tutorial 2. NPB LU-hp Removing False Dependences

This tutorial demonstrates the basic user interaction with CAPO: removing falsedependences to

improve the quality of data dependence and directives analyses. False dependences usually arise from

insufficient knowledge of certain parameters (such as from READ statements or calculated at runtime)

during CAPTools data dependence analysis. With the Directives browser, the user can inspect the

results and remove these false dependences if needed.

The example is one of the benchmarks from the NAS Parallel Benchmark (NPB) suite. The benchmark,

LU-hp, uses an SSOR algorithm to solve the Navier-Stokes equations in three dimensions. A hyper-

plane implementation of the SSOR algorithm is used in LU-hp. The code is split into many .f files. In
order to load the code to CAP(9, we first create a list file "All.list" that contains names of all the .f files.

Steps of parallelization:

, Load file and enter user knowledge. Click Load F77 Source in the File menu. Select

All.list and click the _ button. Select READ Knowled_,e from the Edit menu. In the READ

Knowledge window, select variable nx0 and click [Positive Nontrivial l, see Figure T2-1 on next

page. Apply the same steps to variables ny0 and nz0. These three variables define the number
of grid points in each dimension. Making them positive nontrivial (> 5 in the current case)

improves the quality of data dependence analysis.

, Perform the data dependence analysis. After the user knowledge is entered, in the

Analyser window select the [_ option and click _-_--_. On an Indy RS000 workstation, the

analysis process takes about 18 minutes.

3. Save to database. In the File menu, click Save Database. Enter a filename for the database

(lu_hp_full.dbs) and click _-_.

, Browse directives. In the View menu, click Directives to perform the directives analysis.
The Directives browser will be popped up shortly. Select the [All Routines t scope and browse

through all loop filters. Pay attention to the serial loops (Totally, Covered and Falsely. For

meanings of these loop types, refer to Section 3.2 in Appendix).

a Remove false dependences. In the Directives browser window, select the _'otally Seria_

loop filter and the [All Routines] scope. There are four loops listed under this category. Choose

the first loop: blt s : 1 / 1 / 3 5 : do n=l, np, I and click the _ button. The WhyDirectives

window as shown in Figure T2-2 will be popped up. As indicated in the window, the

serialization of this loop is cattsed by loop-carried data dependences from two variables: v and

tv. After inspecting the loop, the user realizes that this loop performs calculation for all points

on a given hyper-plane. Each point on one hyper-plane could be calculated independently, thus
in parallel. However, indirect indexing was used to access data elements on the plane and these

indices were calculated dynamically and not available at the data dependence analysis stage.
Conservative decisions were made to keep these data dependences during the analysis. 5o, the

user can safely remove these false dependences to enforce a parallel loop: using either the

DepGraph window (in CAPTools) or the WhyDirectives window here (simpler). With the
second method, select variable v and tv in the three lists (True, Anti and Output), click the

button and click the _ button to confirm the action. Apply the same procedure to

the second loop:buts :1/1/35 : do n= i,np, i.
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TUTORIAL 2. NPB LUoHp REMOVING FALSE DEPENDENCES

G Ir,_ger _ ms REAO:

_era read _nlpqt 1S9 read(_ZT-3.t'l_-*)xpr. L_or_

xpr:reM_u_ut 1Sg:ceM(lar_-3,rlfr-o) xpr .in•r,

XtaM_. rnd inlpU¢, 162: read (tMIT-3, FUr-* ) i_

ImcO:read_/ni_t:tTd:re-a(mcrr.3.1_¢-*) ra_ ,aT0.ea0

ny0:=e'a_inlTat:174:ra-aOmIC-3,r_.o)nx0, my0 ,as0

_¢0 : r osd_m,-eput: 1"/4 : re _a C0mlT- 3.1_'1'- ° ) nz0. ny0, M0

Values r_rom Profiles

._J.

Positive NonU'ivl_l } Positive _ Neqatlve NonU'ivisl ) Negative )

Positive Nenl_rJvlel Default: 5 '____J

Negative Nontrivlel DeflluK: -'5 ,___._

User knowledge: nxO

i "I%'P r*a_p=, zr_

160 read _IT-3, F1rf-.)
161 read (tJ_l'l"- 3. F'ItL' -')

162 reed (O'alT- 3. rift-') zu._x

163 reed (Ullf IT- 3, t_iT..)
164 r • ad (t/l_IT. 3, fliT- • )

I&S r • ad (_zfr'l'. 3, nil'. • ) d:

T66 r sad (_lrrr.3, l, wr. °)

167 read (UWIT- 3.rEr, • )

168 read (UNIT- 3, flTr-" ) oaecJe

170 cead(USZT-3. FLIT--)

1"/1 read (t_ZT- 3. P!cr..) tclrsd (I), toL_ 5d (2). tolrsd (3), toLrsd (4). tolr_d ($)
172 : clad {OYZT- 3, flfZ-.)

173 t • ad (UWIT- 3, Flfr- • )

II
175 close (3)

177 apt-apt_default
178 tale=a- m.nora de fault
179 z rJLax, z Uacx-de f ault

180 dt-dt def au[t

181 oae_;ouga defauZt
182 tolred (1) -_Lrsdl def
183 tolrsd (2) -¢olrsd2-def

184 tolrsd(3) -_OL_ sd3-def

185 tolr_d (4) -SeLf sd4-def

3 User Knowledge Items:

nz0 >- 6

i rat0 _- 6

Otsmiss r; Help- ;

,

,

Figure T2-1: The READ Knowledge window for entering initial user knowledge.

In the Directives browser window, select loop filter _alsely Seria_ and sub-filter _"rivatizatior].

Two loops are listed in this category. Choose the first loop: jacld: 1/1/160 : do n=l ,np, 2
and click the _ button if the WhyDirectives window is not visible. A new set of variables is

shown in the window, Figure T2-3. By the same token as above, the user selects those variables

listed in the Output-dep list and applies _ to delete the relevant loop-carried Output

dependences. The variables in the In/Out-dep list were not selected because they are indeed
used outside the current loop. If a variable is removed from the In/Out-dep list and kept in the
Output-dep list, the variable would be privatized, which is not what we want here. Use the same

procedure on thesecond loop: jacu:i/I/160: do n=l,np, I.

Save new database and re-perform the directives analysis. Once data dependences
are modified, it is wise to save the results to a new database. In the File menu, click Save

database. Enter a filename for the database (lu_full_prtme.dbs) and click _'_ To re-perform

the directives analysis with change_ into account, click the IUpdate Directives_ button in
the Directives main window and FUpdat_ to confirm the action. After the update, you will

notice the four loops treated above are now listed in Chosen (parallel). CAPO automatically
recognizes five reduction loops, two of them being array reductions.

Produce OpenMP code. In the File menu, click Save OpenMP Directives Code. Choose the

Single Filename setting, enter a filename (iu_hp_omp.f) and click _v'_. The log file,

lu_hp_omp.log, contains additional information and statistics for the parallelization process.
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TUTORIAL 2. NPB LU-HP REMOVING FALSE DEPENDENCES

, I

• il_F"_"±"=_ _JE_'-'_-L- .... = ...................... , ......-::...... _ " -- " "i,._1 L_
,,,,.?*_wl . - ------!_ '--'_ ............ II [111 _ ,1 "- - _11n[_ ....... I .......... 'l&"_l(,.,_J

Loop: blt, s : 1/1/35 : do n-l, rip, 1 Keuon: with True dependencies, i.e. with recur_ion

Type: Totally Serial New Type.,. I True-dep. variables Anti-dep. variables Output--dep. variables

Hints:

1 variable with loop-carried

tr_e dependencies (Level-I)

2 variables with loop-carried

anti dependencies (level-I)

1 variable with loop-c_ried

out.put dependencies (level-l)

Select All ) Select All )

Remove... )t_,, v, v, v

' I-

I O/Exit state me nts: Contains parallel loops:

i
Inside parRllel loops:

Select All )

Dismiss )

Figure T2-2: The WhyDirectives window for a Totally Serial loop. It can be used to remove false
dependences for the selected variables.

To compile the OpenMP code on the SGI Origin2000, do

% f77 -o lu_hp_omp -03 -mp lu_hp_omp.f

To execute the parallel code with 4 threads, do

% setenv OMP_NUM_THREADS 4

% ./lu_hp_omp

The output (for a class-W problem on 195MHz O2K) looks like:

Programming Baseline for NPB - LU Benchmark

Size: 33x 33x 33

Iterations: 300

Time step 1

0.I161399311023E+02 0.I161399311023E+02 0.3074289103934E-13

Verification Successful

LU Benchmark Completed.

Class = W

Size = 33x 33x 33

Iterations = 300

Time in seconds = 52.74

Mop/s total = 342.43
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TUTORIAL 2. NPB LU-HP REMOVING FALSE DEPENDENCES

_I.___,_,._ ......_-__mt_ti_,_ _.__.:._.._-,:_._,,,__,__,_. a_:__ _.I'II

Loop: _acld:l/1/160: do n-l._. 1

Type: Falsely Serial New Type,.. )

Him:

4 va_iab].esvit.bl_op-carried
ou_ut dependencies (level-I)

e0ndnon-privatizable, due to

usage frol outside the Loop
4 ou_put-de_ (>) vaxi_b_s

._J

Reason: anti/output dependencies, variable not privatizable

Anti-dep. variable: Output-dep. variables

c :.:: : _ " .-'" )C

JJ

In/out--dep. variables

Select All )

IO/F, xit statements: ._. Contains parallel loops: Inside parallel loops:

Figure T2-3: The WhyDirectives window for a Falsely Serial loop. The loop-carried output dependences
for variables a,b,c,d are selected for removal.

The output from a single process execution looks like:

Programming Baseline for NPB - LU Benchmark

Size: 33x 33x 33

Iterations: 300

Time step 1

0.I161399311023E+02 0.I161399311023E+02 0.3227238810597E-13
Verification Successful

LU Benchmark Completed.

Class = W

Size = 33x 33x 33

Iterations = 300

Time in seconds = 155.97

Mop/s total = 115.80

We have a speedup of 2.96 on 4 CPUs for this partictdar problem. If the pipelined LU were used, the

performance would be better (speedup of 3.32 on 4 CPUs). A version of the LU benchmark using the

pipeline algorithm is included in directory LU. Parallelizing LU with CAPO is straightforward and

similar steps as for parallelizing the hyper-plane LU can be followed. The difference is that the user

does not even need to remove any false dependences when generating the OpenMP code (skip Steps 5

and 6). CAPO is able to automatically set up the parallel pipeline.

CAPO User Manual T-6



Tutorial 3. NPB MG User-Defined Loop Type

This tutorial was included in Version 1.0 of CAPO to demonstrate how the user enforces loop type to

improve the performance. This kind of interaction is not very often and can be done either within or

outside CAPO. The outside interaction is often involved with direct change to the source code. In the
following we first show the steps of parallelization without any change and then ilkrstrate two ways of

user manipulation to the source code.

The example is one of the benchmarks from the NAS Parallel Benchmark (NPB) suite. The benchmark,

MG, uses the V-cycle multigrid algorithm to obtain an approximate solution to a discrete Poisson

problem in three dimensions. The norm of the solution is calculated in each iteration to check for

convergence. As was done in Tutorial 2, all the .f files are first listed in a single file: al 1.1 i s t.

Parallelization of the original code.

1 Perform the data dependence analysis. Click Load F77 Source in the File menu. Select

All.list and click the _ button. In the Analyser window select the _ option and click

_--_-'_. On a Sun workstation, the analysis process takes about 20 minutes.

2. Save to database. In the File menu, click Save database. Enter a filename for the database

(mg_full.dbs) and click

, Browse directives. In the View menu, click Directives to perform the directives analysis.

The Directives browser will be popped up shortly. Choose scope _11 Routines l and loop filter

sub-filter [True Recursior_l. Select loop: norm2u3 : 1/1/27 : do i3=2, n3-1
button. Figure T3-1 is what you will see afterwards. The loo-p ne-_ (-anJ _¢_o

others inside) contains an IF statement which prevents the loop being recognized as a

reduction loop over variable rnmu'. In order to be a valid reduction statement for OpenMP, the

code needs to be modified (see Step 5). Without any change, this piece of code will be run in

sequential.

. Produce OpenMP code. In the File menu, click Save OpenMP Directives Code. Enter a

filename (mg_omp.f) and click _ The log file, mg_omp.log, contains additional information

and statistics for the parallelization process.

To compile the OpenMP code on the SGI Origin2000, do

% f77 -o mg_omp -03 -mp mg_omp.f

To execute the parallel code with 8 threads, do

% setenv OMP_NI/M_THREADS 8

% ./mg_omp

The output (for a class-A problem on 250MHz O2K) looks like:

Programming Baseline for NPB - MG Benchmark

' Due to the improvement in Version l.l of CAPO, the IF-type reduction is now automatically recognized. The
described serial loops will no longer exist. But the concept of u_r interaction from this Tutorial is still valid.
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TUTORIAL 3. NPB MG USER-DEFINED LOOP TYPE

VERIFICATION SUCCESSFUL

L2 Norm is 0.243336530907E-05

Error is _.692S05188218E-16

MG Benchmark Completed.

Class

Size

Iterations

Time in seconds =

Mop/s total =

A

256x256x256

4

6.65

585.42

A single-CPU run of this code took 39.29 seconds. We have a speedup of 5.91 on 8 CPUs for this
particular problem.

Scope:

ail Routines

Loop Filter. Sub:

I Totally Serial All

.Covered Serial i l True Recurston

Falsely Serial t I/O or Exit
!

Reductions I No Granularity
n

Pipeline ] User Defined ,

/Chosen

Not Chosen

Show P_iiei Vo: _ ,o !

CurrQnt Routine: noz-_2u.3

17

18

19

20

21

22

23

24

25

26

24 Routines:

"i
v

n ¢; L';,_U i:

RoutlneC

39

4O

41

4_

13 Totally serltl loops (with True dependencies):

Inorx2u3:l/1/2T: ,t,, i.3-2,n3-1,1

norn2u3:2/2/28: 6o i2-2, n2-1,1

no_2u3:3/3/29: do il-2. n1-1.1

print..re=_l._ :1/I/21 : do ]-13, l, -1

setu_ : 2/2/89: do k-lt-1.1, -1

aetup:6/1/118: ,In ]-lt-1, 1, -1

VB_J_C:I/1-/2_: do i-l,n, 1

zran3:I/1/33: do i3-2. e3, 1

zran3 : 2/2115 : do i2-2. e2.1

zrl_t3:4/1/39: 6o i3-2, n3-i, 1

. , . .. . . . l,. i i i i i

LoOp: nora2_3:1/1/27: do i3-2,n3-1, 1 Keason: with True dependencies, l.e. with roe

Type: Totally Serial New Type... i Truo-dop. variables Anti-dep. variabh

Hints: rmr= "

I e,Jl 2 variable_ vith loop-c_r_ied

true dependencxe_ (level-l)

' 1 v,t_iable with _oop-c_xed I

output dependencies (level-i)

SelectAll )

Reset _ _err_ _a...

IO/Exlt statements:

SelectAll ]

Contains parallel loops: Inside parall_

* i! ,
I

Figttre T3-1: The window shows a serial loop in norrn2u3, MG.

Further _mprovement to the code can be made by parallelizing the loop in routine norm2u3 (the
highlighted area in Figure T3-1). The operations inside the loop nest can be expressed as reductions
with slight code modification. There are two ways to achieve the goal: modifying the serial code and re-
performing the dependence analysis (Steps 5-7) or user enforcing loop type in the tool without re-
analysis (Steps 8-9).
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Modification of the serial code.

5. Modify the serial code. The step involves directly modif3Ang the serial code (mg.f) with an

editor before the analysis. In routine norm2u3, change the IF statement

if (a.gt.rnmu) rnmu = a

to a form that can be expressed with reduction

rnmu = dmaxl(rnmu, a)

Save the new version to mg2.f and create a new list file 'All2.list' to include mg2.f.

6. Perform the data dependence analysis. Click Load F77 Source in the File menu. Select

All2.1ist and click the _ button. In the Analyser window select the _-_ option and click

_---'_T_. Save the result to a database (mg2_full.dbs). Browse directives if you like (View --)

Directives). You will notice the loop in routine norm2u3 is now recognized as reduction.

e Produce OpenMP code. In the File menu, click Save OpenMP Directives Code. Enter a

filename (mg2_omp.f) and click _ The log file, mg2_omp.log, contains additional

information and statistics for the parallelization process.

Now you can compile and run the parallel code as described after Step 9.

User enforced loop type.

8. Define a new loop type. From the File menu, load in the database "mg_full.dbs" from the

previous analysis. Perform Step 3. In the WhyDirectives window, click the _ewT_ button.

Right after the _Reductior_ setting is selected the Reduction Operator dialog box is shown up

(see Figure T3-2). Select variable "rnmu" and intrinsic function "max", and push _-_ in the

Reduction Operator dialog and in the Loop Type dialog. A new entry "R[max:rrunu]" is

added to file "userloop.par" in the current working directoy. This is to inform CAPO to treat
variable "rnmu" as a reduction variable besides other variables (such as "s"). Now in CAPO

click _pdate Directive_ to re-perform the directives analysis, which will take into accotmt the

user-defined loop types from file "userloop.par."

9. Save and change OpenMP code. In the File menu, click Save OpenMP Directives Code.

Enter a filename (mg2_omp.f) and click _ We need to do one last change in the generated

OpenMP code: Use an editor, change in routine norm2u3

if (a.gt.rnmu) THEN

rnmu=a

ENDIF

to an "OpenMP-compliant" form

rnmu = dmaxl(rnmu, a)
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TUTORIAL 3. NPB MG USER-DEFINED LOOP TYPE

Loop: noz",,2u3:l/lj"29: do i3-2._3-1.1

Vartablos: -

;ll.

S

,.,.J

Opor_dmr/l_ns ic

+ .NECk. }

-
" MIN I

.AND. lAND i

.OR. log

.EO.V. IEOR

Figure T3-2: The Reduction Operator dialog after the _,eductior_ setting is selected.

From either method, we should produce the same new parallel code (mg2_omp.f). Use the same process

after Step 4 to compile and rLm the new code. The output from a run with 8 CPUs (for a class-A problem
on 250MHz O2K) looks like:

Programming Baseline for NPB - MG Benchmark

VERIFICATION SUCCESSFUL

L2 Norm is 0.243336530907E-05

Error is 0.694753363997E-16

MG Benchmark Completed.

Class = A

Size = 256x256x256

Iterations = 4

Time in seconds = 5.67

Mop/s total = 686.60

The new code took 39.12 seconds on I CPU and 5.67 seconds on 8 CPUs, a speedup of 6.90 and 14%
improvement over the first version.
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Tutorial 4. A More Realistic CFD Application

The sample code, teamkel, in this tutorial has been taken from one of the CAlq'ools' tutorials with a

slight modification. This is a more realistic application. It includes structures that may be encoLmtered

in many scientific applications. The example illustrates an incremental approach to achieve good

performance with assistant from CAPO and other tools like SpeedShop (available on the Origin 2000

machine). These tools are used to pinpoint problematic code sections quickly so that the user can apply
necessary changes.

Parallelization of the original code: teamkel.f

, Perform the data dependence analysis. StartCAPO, clickLoad F77 Source in the File

menu. Selectteamkel.f and clickthe _ button. In the Analyser window selectthe

option and click_--_. The analysisprocess takesonly a few n-unutes.

2. Save to database. In the File menu, click Save Database. Enter a filename for the database

(teamkel_full.dbs) and click _-_--_.

3. Perform the directives analysis. In the View menu, click Directives to perform the

directives analysis. The Directives browser will be popped up shortly. Choose the [All Routine_

scope and browse through different loop filters. You will notice there are a qlrite number of
Totally Serial loops (see Figure T4-1), which will limit the performance of this code. At this

point, we only look into more details of the loop nest in routine CM.,CP1. The rest of the loops

will be discussed in Step 5 and after.

Choose the loop "CALCP1:1/1/3 5 : DO 100 I=2, NI, 1" and click _----_. The WhyDirectives

window indicates the loop was serialized due to loop-carried dependences for variable su. The

DepGraph (activated from the right-mouse button Loop Menu over the selected loop) shows
level-1 and level-2 dependences from statement 50 to 52 to 55 (see Figure T4-1). In particular

the 52 --_ 55 dependence prevents even a pipeline being formed within the loop nests. In fact,
we realize the add operation for variable SU in statements 52 and 55 is associative, thus, the

execution order of the two statements can be switched and the 52 _ 55 dependence can be
removed.

In the DepGraph window, click the 52 ---) 55 dependence edge with the right-mouse button and

load the "Why Dependence?" window (see Figure T4-2). Apply the [Remove This Dependence]

button and confirm the action. Save to a new database if you like. Click _pdate Directive._ to

re-perform the directives analysis and a pipeline is automatically recognized in routine
CALCPI.

Loop types are strrnmarized here:

25 Totally Serial loops

10 Reduction loops

1 Pipeline loop in routine CKL,CP1

45 Chosen (parallel) loops

4. Produce OpenMP code. Without additional change, in the File menu, click Save OpenMP

Directives Code. Enter a filename (teamkel_omp.f) and click _--_.
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i__
"-I :_ , CAPO: OlrectJves|rowser_-;-_._ ,, = " • _-'_'_-'_¢_ ; _1

27 Totally serial |eops {lJ. not within or containing pawallel leejs):.Scope-

[ All Routln_ '

Loop Rlter= Sub:

True Recurslon

L/O or Exit

No Granularity

Usor Defined

Covered Serlgd1

Falsely Serial

Reductions

Pipeline

Chosen

Not Chosen Idore Filter.., )

Current Routine: CJ_CJPI

-_T
32
33
34
35
36
37
38
39
4o
41
42
43
44
4S
46
47
48
49

C_ttPl

C_t_r2

t_LCU

,"KI.Cv

26 Ruutine_:

v

i

I
........................ ._.1

CALC_:1/1/42:D0 100 Z-2.llZ, 1

C1_C=_:2/2/43:00 100 3-2,11J,1 Loop Menu

ICI_I:II3J3S: 'DO 100 Z-2.1rL1 ( Routine GIlls-

C&M_1:2/2/36: _ 100 ;-2,113.1

C&L(=P2:1J3J27: DO 100 Z-2,11L1

CJ_1:72:2/2/28:D0 100 3-2,xJ. 1

CJ_CT:l/1/48: DO 100 ;-2.1rLt

CILCT:2/2/49. + DO 100 ;-2,115,1

C&LC3Z:l/1/41: DO 100 Zo2.lrz. l

CH,C'_:2/2/42: DO 100 3-2,NJ, 1

CJ_I.CU.1/1140 : D0 100 I-2.Imll. 1

RoutineOup., +) _ Update Directives.. _ Setti

User Loop:

: C0]Oi0)f
C0)010N /(Y11_1/)IPII_, HAXI_, l_rVIS. UI_0L3I, IHOII, 3X0H. IPREP. _PREF, SORX_X,r_0vI_, XN01IZ!

C
C *** AS_LY OF CO_IC_]#_S

D0 100 1-2. HI, 1
DO 100 3-2, H3.1

C "'"

A/UCAV°I_SYCV(3 )
;_[_s-sxcv (z) *_v(3-1)

C *** CJ_C_,.A_E COEPFICIEN'I_
DENV-DIrN (I-l. 3)+IX (I-1)* (DEN (I,3) -DI'H(I-l, 3) )
DENS-DEN(I, 3-i) +FY(3- l)* (DEN (I,3) -DEN (I,3-i) )
AV ( I, 3 ) -DE'IW •ARJCAV*DU ( Z- 1, 3)
_(z-l, _)-AV{Z, 3)

• _(z, _)-o_'s,P,_z^s.ov (z, J-z)
l _ ( Z, 3-1)=_(I. J)
:C *** C_COLACE SOURCES
: CV-DI_IV*U (I-l, J) *Jr_v
: CS-DEZlS*V *_Lr.J,S

Routine Callars_

_,_4m_ r

Partitioner_

Transformations P

Call Graph_

Dep Gra.ph_

Locps-

_js/Commo_s_

VIM"De flnltto+t.

Global Vars_ •

_ +._y.:...

C-){11IYi_+.

Oire_ive_

List _-

Help.___=.;

.... .-k.--.

Figure T4-I: The Directives Browser window displaying Totally Serial loops in teamkel. The Loop Menu
is used to activate the DepGraph (shown as inset) for the selected loop.

raph Dependence2 Men I

1 _( Why DependenCe? )

I _ P_rUtloner...
Transformetions

Loops...

Args/Commons...

Vat Definition..

Global Vars...

Masks..,

Comm$..l

Directives...

Figure T4-2: The DepGraph Dependence Menu after clicking on a dependence edge.
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To compile the OpenMP code on the SGI Origin2000, do

% f77 -o teamkel_omp -O2 -mp teamkel_omp.f

or use the supplied Makefi!e

% make VERNO=I

To execute the parallel code with 4 threads, do

% setenv OMP_NUM_THREADS 4

% ./teamkel_omp < inp.dat > teamkel_omp.out.4

Use the SpeedShop tool available on the Origin 2000 to profile the code. For I CPU:

% setenv OMP_NUM_THREADS 1

% ssrun -pcsamp ./teamkel_omp < inp.dat > teamkel_omp.out.l

A sampling filenamed as "teamkel_omp. pc samp.m(pid)" willbe created.Here "(pid)" isa proper

process id.Use the "prof" command tocreatethe profileoutput:

% prof teamkel_omp teamkel_omp.pcsamp.m(pid) > teamkel_omp.prof.l

Follow the same procedure to obtain

profile on 4 CPUs. The profile outputs

for the key routines on 1 and 4 CPUs

are compared in Table T4-1. "ratio" is
1-CPU time over 4-CPU time, or the

speedup on 4 CPUs. The error of ratio is

calculated from the statistical sampling
error reported in the profile data. As we

can see, except for two routines

(calcpl and props), the major

routines do not scale. The poor

performance correlates with the Totally
Serial loops indicated in Figure T4-1.

These loops were executed sequentially.
In order to improve the performance,

we need to investigate and find a way
to parallelize these loops.

Table T4-1: Comparison of profile results for the first

parallel version of teamkel. Time is given in seconds.

Function 1CPU 4CPUs ratio error

LISOLV

CALCTE

CALCV

CALCU

CALCED

CALCT

calcpl

CALCP2

props

init

PRINT

16.18

9.53

8.95

8.58

8.10

7.10

4.78

4.11

0.48

0.25

0.06

16.89

9.06

7.86

7.58

7.71

6.47

1.59

4.03

0.16

0.15

0.20

0.958

1.052

1.139

1.132

1.051

1.097

3.006

1.020

3.000

1.667

0.300

0.033

0.049

0.056

0.056

0.053

0.060

0.275

0.071

0.866

0.544

0.140

Total 80.83 74.21 1.089 0.018
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Version 2 - Code modification without change to the basic algorithm:

S, Inspect code sections. Restart CAPe and load back teamkel_hfll.dbs (Load Database in

the File menu), in the View menu, click Directives to perform the directives analysis. In the

Directives browser window, choose scope _All Routine 4 loop filter _otally Seria_ and loop

"CAGCTE:2/12/42: DO 100 J=2,NJ". Click the _ button and the WhyDirectives

window as shown in Figure T4-2 will be displayed. There are six variables with loop-carried

true dependences, five of which have a determinable dependence vector length as indicated by
"[ 1 ] ". This is an indication of a potential pipeline loop if changes can be made to variable tyx

and two other variables vE and SMZ:rv¢presented in the Output-dep. variable list.

Loop: C,1U,C'/Z:2/2/42: DO 100 J-2.11J.1

Type: Totally Serial New Type.__ True-dell. varlobles

Hints: MI

i ; _iablee vi'cb loop-cerried

, _ d_pendencie= (1ere1-2)
3 vaziabZes v*th loop-c_r¢ied

_¢i deperLdeacie= (level.-2)

3 v_i=hl.e. ,fit,,b ].oop--c_cied

out:put depemdencies (level.-2)

I O/FJdt state me nts:

!_

Reason: with True dependencies, Le. with recursior

Anti-dell. variables

Jm Ill Se

mm_ II1 _s
so IH

se[I!
• s [11

i

Select All_)

Reset ) _e rA._a. '

Contains parallel loops:

_L

Outllut-dell. variables

"iI

011

"Is, _

Select All '_

Inside parallel loops:

it_
Dismiss ] Help... )

1

Figure T4-3: The WhyDirectives window for a Totally Serial loop in teamkel.

Change scalar assignments. Checking the code section in loop nests T and J, we realize

that the dependences on scalar variables LrN and VE were caused by the reuse of the assigned
values from the previous J or I iteration in an IF statement. The dependences can be removed
if we recalculate both variables at each G or I iteration.

Start a text editor and load in teamkel.f. In subroutine CALCTE modify the assignment for LrN
from

to

IF(J.NE.NJ)UN=0.5*(U(I,J)+U(I-I,J)+FY(J)* (U(I,J+I)+U(I-I,J+I)-

> U(I,J) -U(I-I,J)

IF (J.NE.NJ) THEN

UN=0.5*(U(I,J)+U(I-I,J)+Fy J)*(U(I,J+I)+U(I-I,J+I)-

U(I,J) -U(I-I,J)
ELSE

UN=0.5" (U(I, J-I )+U(I-I ,J-I +FY (J-l) * (U(I, J) +U(I-I, J) -

> U(I,J-I)-U(I-I,J-I) ))
ENDIF

and forVE from

IF(I.NE.NI)VE=0.5* (V(I,J)+V(I,J-I)+FX(I)* (V(I+I,J)+V(I+I,J-I)-
> V(I,J) -V(I,J-I)
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o

,

to

IF (i .NE.N!) THEN

VE=0.5* (V(I,J +V(I, J-l) +FX(I) * (V(I+I ,J) *V (i÷l ,J-! ) -

V(I,J)-V(I J-l)

ELSE

VE=0.5*(V(I-I J)+V(I-I,J-I)+FX(I-I)*(V(I,J)+V(I,J-I)-

> V(I-I,J)-V(I-I,J-l)))

ENDIF

Apply a similar modification to variables in three other routines. The changes are summarized:

Routine Loop Variable Description

CALCP2 DO I00 J=2,NJ SUS, SUW Recalculate at each

CALCTE DO i00 J=2,NJ VE, UN iteration
CALCU DO i00 J=2,NJ GAMN, DVDXN

CALCV DO I00 J=2,NJMI GAME

Expand 1-D array to 2-D. Variable SMPW is a 1-D working array throughout the program. In

order to set up a pipeline of the J loop with the outer I loop, this array needs to be expanded to

twn dimensional. As an example, in routine CALCTE, change the declaration of SMPW from 1-D

to 2-D, i.e. SMPW (NX) --_ SMPW (NX, NY). Then modify the following code section from

CP=AMAXI (0.0, (SMPW(J) +CW) )

SMPW (J) =-CW-CS

SMPW (J-l) =SMPW (J-l) +CS

to

The

declaration from SMPW (NX)

SMPW(I,J) =0.0.

CP=AMAXI (0.0, (SMPW(I-I, J) +CW) )

SMPW(I, J) =-CW-CS

SMPW(I, J-l) =SMPW(I, J-l) +CS

initialization of SMPW is done in subroutine (entry) INIT. In this routine modify the

to SMPW(NX,NY) and the assignment from SMPW(J)=0.0 to

Similar changes

here:

Routine Loop

CALCED DO 100 J=2

CALCT DO I00 J=2

CALCTE DO i00 J=2

CALCU DO 100 J=2

CALCV DO 100 J=2

INIT DO 951 J=l

are made in several other places. The modifications on SMPW are summarized

NJ

NJ

NJ

NJ

NJMI

NJ

Description

Expand SMPW from 1-D to 2-D

Change declaration in the whole program

All the modifications do not alter the basic algorithm, so the same run-time results should be

expected. Save the modified code to a new file: learnke2.f.

Perform code analysis. Restart CAPO and load teamke2.f. Perform the Full data

dependence analysis and save to tearnke2_full.dbs. Start the Directives browser from the View

menu and the Directives menu item. With the [All Routine_ scope browse through different

loop filters. You will notice that the number of Totally Serial loops has been reduced from 25 to

13 with increase in the number of pipeline loops. Loop types are summarized here:

13 Totally Serial loops (mainly in routine LISOLV)

10 Reduction loops

7 Pipeline loops

45 Chosen (parallel) loops
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9. Produce OpenMP code. In the File menu, click Save OperL%IP Directives Code and save to

file teamke2_omp, f.

Compile and run the parallel code as before. The SpeedShop profile results for the new parallel code are

summarized in Table T4-2. As one can see, the parallel performance of Version 2 has been improved in

almost all routines except in routine LISOLV. LISOLV still executes serially and affects overall

performance. The single CPU execution time increased slightly in comparison with the original version.

This is because the recalculation of scalar variables in the new code costs slightly more time.

Table T4-2: Comparison of profile results for the second parallel version. Time is given in seconds.

Function 1CPU 4CPUs ratio error

LISOLV

calcte

calcv

calcu

calced

calct

calcpl

calcp2

props

init

PRINT

16.14

9.89

9.28

8.82

8.76

7.79

5.04

4.06

0.53

0.28

0.14

18.00

3.19

2.92

2.83

2.87

2.39

1.75

1.11

0.20

0.13

0.26

0.897

3.100

3.178

3.117

3.052

3.259

2.880

3.658

2.650

2.154

0.538

0.031

0.200

0.213

0.213

0.208

0.241

0.253

0.392

0.695

0.723

0.178

Total 83.77 46.67 1.795 0.033

Version 3 - Change of algorithm in LISOL V:

10. Inspect code sections. Restart CAPO and load back teamke2_full.dbs (Load Database in

the File menu). In the View menu, click Directives to perform the directives analysis. In the

Directives browser window, choose scope [All Routines_ loop filter _ and loop

"GISOLV:2/2/18: DO 100 I=ISTART,NIMI". Click the right mouse button to activate the
Loop Menu. In the menu choose Dep Graph and the DepGraph window will show data

dependences that serialize the loop (see Figure T4-4 and the inset): variable PHI at level 2 (loop

I) and 3 (loop J) and variable A,C at level 3 (loop J). In loop I, variable PHI is used to calculate

A and C and gets updated at each I iteration.

11. Modify the algorithm. We can use a more explicit algorithm in the I loop: Variables A and c

are calculated for all the values of I before variable PHI is updated. The I loop then becomes

parallel. The impact of such a change is mainly on the convergence speed of the tmderline
algorithm. One may have to balance convergence rate and parallelization. In this case

parallelization seems to be more important.

The modifications to the code involve expanding the dimensionality of A and c from I-D to 2-D

and splitting the I loop into two parts: the first part calculates A and C from PHI and the second
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Figure T4-4: The Directive Browser window for Totally Serial loops in teamke2. The highlighted code

section in routine LISOLV is to be modified to a more explicit form.

9 DII_NS I ON PIll (NX, NY). k (liD[, liT). B (lCX) , C (NX, NY), D (NX)

l0 _Z_SIOW AI (Ir_) . BI (_X), C1 (WK), D1 (N'X),/_ (If)(, re'), H¢ (lgx. Iff).

11 NIl(1-1CZ

12 NJR1-NJ

13 _ S1"_1- J S'EN_- 1

14 IS'I_1. I ST.AKr- 1

15 DO 2000 IT-l, NSV. 1

16 C --- COI,D_NCE V-[ S'¢[Lrlp

17 DO 101 1.-1._T_.W1.K1, 1

18 M I. 3Y_'NI)-0 0

19 C (I, J$_I)-PHI (I. J$"_1)

20 C --- C010_I, IC _r $*N 'rRAVT.RSE

2I D0 101 3-JS'rAR¢,H.IXl, 1

22 C --- Ag$[!_L r TI:IMA COEFFICIENTS

2] A(I, 3).AH(I .I)

24 B(J)-AS (I. J)

25 C (I. J) -_ (I. 3) "PHI (I*l. 3) -AV (1, 3) *PHI (I-l, 3) *$U (I. 3)

26 D(J) -_P (1..J)

27 C --- CABCLrLAT_ C0_FFICIENT$ or BICLrRREHC[ FORMULA

28 TE,P_- i / (D (3) -S (3) "^ (1.,3-1) )

29 A(I, J) -A(I. J) _'I[RR

30 101 C (I. J). (C (I. J) *B iJ) *C (I, J-I))*TEBX

31 COI_. 1.NI_

_2 C --- OBTAIN _EW PHI@S

33 DO I00 I-IYr/dvr. NIlql.l

34 DO 102 JJ-JS"CAK_. WJNI, 1

35 J -N J* J ._TAKT-/J

36 102 PMI (I, J) -A(I. J)*PHI (I, _-I) -C (I. 3)
37 100 C0_FrI_

Figure T4-5: The modified code section after loop I is split into two parts.
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12.Perform code analysis. Restart CAPO and load teamke3.f. Perform the Full data

dependence analysis and save to teamke3_full.dbs. Start the Directives browser from the View

menu and the Directives menu item. With the _All Routine_ scope browse through different

loop filters. You will notice that the number of Totally Serial loops has been reduced from 13 to

6 and these loops are in routines GEOM and GRID. Loop types are summarized here:

6 Totally Serial loops

10 Reduction loops

7 Pipeline loops

49 Chosen (parallel) loops

1 3. Produce OpenMP code. In the File menu, click Save OpenMP Directives Code and save to

file teamke3_omp, f.

Compile and run the parallel code as before. The SpeedShop profile results for the final parallel code are

summarized in Table T4-3. As one can see, the parallel performance of Version 3 has been improved
over Version 2 and a reasonable speedup has been obtained. The single CPU execution time of routine

LISOLV increased about 40% in comparison with the previous version but the parallel execution time
decreased quite a bit.

Table T4-3: Comparison of profile results for the third parallel version. Time is given in seconds.

Function

lisolv

calcte

calcv

calced

calcu

calct

calcpl

calcp2

props

init

PRINT

Total

1CPU

22.71

9.74

9.11

8.89

8.74

7.83

4.87

4.0]

0.52

0.27

0.05

89.92

4CPUs

7.47

2.95

2.78

2.55

2.64

2.34

1.80

1.07

0.24

0.12

0.37

36.23

ratio

3.040

3.302

3.277

3.486

3.311

3.346

2.706

3.748

2.167

2.250

0.135

2.482

elror

0.128

0.219

0.225

0.248

0.232

0.249

0.236

0.408

0.535

0.781

0.064

0.049
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Tutorial 5. Mix of Message-Passing and OpenMP

This tutorial demonstrates one way to generate a hybrid parallel code with CAPTools/CAPO. The

parallelization is done at two levels: message-passing (MP) at one level and OpenMP at another. The

example relies on the thread-safe feature introduced in MPI-2 and the success of execution depends on

the implementation of a thread-safe MPI-2 library. We need to emphasize that the hybrid parallelization

here is not the best way to achieve good performance for the currently selected code. We mainly like to
illustrate that it is possible to produce a hybrid parallel code with the tools.

The example is one of the benchmarks from the NAS Parallel Benchmark (NPB) suite. The benchmark,

BT, uses an implicit scheme to solve the Navier-Stokes equations in three dimensions. Within one time

iteration the solver sweeps through each dimension successively. Each step has strong data

dependences in the swept direction, but is completely parallel in the other two directions. The multi-

level parallelization is achieved by first distributing the data in the u dimension for message passing

and then applying directives on loops working on the K dimension. Small modification to the generated
parallel code by hand is needed in order to work around an incompletion due to that the hybrid code

generation is not really supported by the current tools.

The sequential version of the source code is in directory BT-raix. In order to load the code to CAPO, we
list all the .f files in one file: All. list.

Parallelization with message-passing at the first level:

. Load source and enter user knowledge. Click Load F'/-/Source in the File menu. Select

All.list and click the _ button. Select READ Knowledge from the Edit menu. In the READ

Knowledge window, select variable nx and click [Positive Nontrivial_ see Figure T5-1 on next

page. Apply the same steps to variables ny and nz. These three variables define the number of

grid points in each dimension. Making them positive nontrivial improves the quality of data

dependence analysis in Step 2.

1 Perform the data dependence analysis. After the user knowledge is entered, in the

Analyser window select the _ option and click _ On a Sun Sparc (Ultra-4)

workstation, the analysis process took 12 minutes.

3. Save to database. In the File menu, click Save Database. Enter a filename for the database

(bt_full.dbs) and click

, Partition data. Launch the Partitioner from the CAPTools main window. Choose routine

"add", array "u" and index "3" (see Fig_,re T5-2) and click _enerate Partitior_ This step creates a

data distribution for array "u" on the 3_ index (the J dimension) and CAPTools also partitions
automatically the relevant arrays throughout the program. Figure T5-3 shows the partitioning

window after the process is finished. You will notice that array "lhsb" was left Lmtouched. The

next thing to do is to select this array, index 4 and perform another partitioning.

5. Save to database. Use the Save Database menu to save the partitioned data to bt_part_j.dbs.
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i

4 Imtalmr Vmr= ai_ READ:

_' n_c*¢ Iff 214 read(_ar_.3.1n_.*) _t=c

_ rmlff 115 retd(10=rl_.2, t_T.*) _ ,nlr, r_

m/iT;t75 [oad0mZT*t.t3fl"-*)_. By ,nz i

•=t¢ IrJr:t7i;_=e-_(grl"_2 rla_*)r_.ny _ i

E

_L j

Pca_tb_ _$o_trlvlel : Polillvo k0ativo Non_*iv_l NaWstive t

hslUve Nsntrlvlel Default __ _. =,_-

Negative _ntrlvlll Default: -5 ._

User Imewledge: nz .GT. 5

VslmIs Frmm Profiles 3 User Keswle411e Rams:

"-- r: )*(

i
i

_ 1

162!i.,
iiTM166

i 16_

168
159
110

, 111

112

113
114

115

i 117

: 118

119
180
Is1
192
18]
184
18S

I i 186

I 11B7
_J

¢._n=me| (t_=solve) .' ztoZve'
_ nms(t_rdz)L) * ' _edL=¢I"

• ¢._r,_met (t_t dl o2) • TM redt$_'
t; _l*m (t__d) -' idd'
c_em*(2)

el=e
t:ume[_m. |_l_e

t_r _ _ (ial1_- *. rlrlr • 100o )

opmt (umx¢-2. fll**'u_pu_bt dt¢.i', Jt.acu=.*o_'. ;oscJat*fs

v¢_ (l=lllr.*, 1qC.2)))

233 forlsat(" Pam_dX_l free l_pu_ f_l* zr_u_b_ d_a')
J:wad(_5fI_- 2, FR'1%* ) e,IL_11"
[etd (UW_=2, !_'Z'= * ) dt

¢].ese(2)

gild .ne_.n¢_ (2) -ny
_id pe_.n_ (3) ,nz

else
vzl_r (U)rT_.*./3r1", 2 _4 )

: _ltec*nltet default

dt-d_ defau_t
g_td _po_nts (1) .p: obl*= _kze
g_zd pozs_C4(2) -p_oble=-_=*
g_zd poznts (3) -pz oblem:)_ze

Dismiss ) Help-- )

Qoh:k Clmlc_: I_.k: )_wmediatm

An slysis to le¢lu4e: I K.'n,owk.d_e I O,Isimroe_, ,

I_:"' i'=,'_
De..d.=t.,=1"o Ore.,,

Limit Aneiysis Time: _ _-_;_'._

.)

Analyse _ Oismiss Help_ ,

Figure T5-1: The READ Knowledge window for entering user knowledge and the Analyser window.

• -, L_ ..... ,,,,,, ,,,, , ,, , i_i_.mn,,_-: " , _ - ;' ._'_._,'_,,'_,_..;,_._;_-,_;10
Routines:

RUe Vm'iable Spoclfica¢loe:

V=risbl_: u

Va_tabie Imle_= _L
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Divisor.
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Ilkxk/Cydl¢ I Unsr_u(tured

Iml_Kloe A_l_n_:

Maximum Against: 0 !

irt)r/ARelnst Ratio: 0

Pwtltlee AIIDnment:

Tsleronce: S , ;_

Part_&eaing Options:

_r,,E!%_L_,?_9,,_t;_;_F, tp__:: _*m,_ ]
add: 24 Unpert_tlensd Arrays

! Name Index For Against

) q_ (0 IS_X, 0 : 31tA_ 0:10_ 0 0 0

I d_ i (0: n_X. 0 : _Ud_ 0 : I_0 0 0 0

t I du (S. 0. Z]mL 0; nL_L 0. De0 0 0 0

s,q_e (0 : _r., 0 : ,_ 0 li:]OklO 0 0 0__b)ack (S, S) 0 0 0

i tap he(S) 0 0 0J u (S. 0: mml 0 :.nO, Z. 0 _DnkZ) 0 0 0

i ue ( "l :Pr'kla-eile*l" S) 0 0 0
! m(o nero _U[,O Dg_Z) 0 0 0

wm(0: niaz. 0 :_ 0 JomuO 0 0 0

Llrm_m_ti)ll_.,d Co,?.b).(_. W yi_ F+lIrc-,s_;. " Pilrvent j Undo,%'l_lnt_orts

add: O Pertitleaed .4rays
r-- ...........................
; Name Index Define Range Pau_ltlon tangs

:. Khowlsdge ! (xk't

i Interpro_sdural Logk _eher_tl P08_lt_t::: :_ :j_ _:; .:r :_;:,; _: -,..k'[ ;tyh:; : :;

PartitIonin_l...

Olsmli$ ,

Figure T5-2: The Partitioner window for array partitioning: routine add, array u, index 3.
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Routines: re,,. '<'r" 3 C: _:i;¢ n L;_. .He_IP" I

" =M ........... add: 15 Unpartitiened Arrlvs
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Figure T5-3: Apply array partitioning on the second array: lhsb, index 4.

6. Remove unwanted partitions. If you use the result produced from Step 4 to generate

message-passing code, you would notice that CAPTools place quite a few communication calls

inside routine COHPUTg_RHS, which exchange boundary values of some of the working arrays
(such as qs, the_±...) for the partitioned dimension. These boundary values, in fact, can be

calculated in the routine instead of being communicated from neighbors to improve the

performance. This kind of improvement can be achieved within CAPTools by removing

partitions on the relevant arrays (although it is not very obvious and intuitive). In the
Partitioner window, select routine "compute_rhs". Select "qs" in the Partitioned Array list

and chck the _)elete Partitior_ button. Apply the same procedure to arrays: rho_i, square, us,

vs, and ws. Figure T5-4 is what you will see after this process from which partitions on six
arrays have been removed.

Click the _ccept All Partitior_ button.

1'. Generate masks and communications Start the Code Generator from the CAPTools

main window. Choose 2 for Men Slabs Per Processor, which indicates at least 2 slabs in the

partitioned direction to be used for the execution and reduces number of comm_mications calls

placed. Select _3ather/Scatte_ for Communication Type. Click _3enerate Mask_ to start the

mask generation and _alc &Gen Comm_ to generate communications. See Fig_re T5-5.

At this point you could produce a pure message-passing program if you wish (the _Generate &_

_ave Final Code_. button). But we move onto next step.

8. Save to database. Use the Save Database menu to save the communication data to

bt comm_j.dbs.
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Figure T5-4: The Partitioner window after partitions on six arrays were deleted.
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Figure T5-5: The Code Generator window for the final generation of message-passing code.
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Insertion of OpenMP directives at the second level:

9. Browse directives In the View menu, click Directives to perform the directives anahsis.
The Directives browser will be popped up shortly. Select the [All Routines l scope and browse

through all loop filters. Pay attention to the serial loops (Tot,_lhl, Covered and Falsely).

10. Re-enforce new loop types. In the Directives browser window, select the [All Routines]

scope, the [Falsely Serial] loop filter and [I/O Statement] sub filter (Figure T5-6). There are two K

loops listed trader this category. Choose the first loop: y_solve : 8/1/302 : do k=l, grid..

and click the _ button. The WhyDirectives window (see Figure T5-7) indicates that there

are four MP (Message-Passing) calls (as part of the parallel pipelines) inside the K loop, which

serialize the K loop. If nothing is done here, the inside T loop will be chosen for the second level

parallelization with directives, which will not give a good performance.

,, i i i , ........

Scope:

All Routines

Loop Filter:. Sub:

! All
Totally Serial j

Covered Serial i Privatization

23 RI)ulinP_:

-,.L'

:'r$?.r Z._,_':[ _.,'.L_I

RoutineOup... ;

Falsely Serial I/0 Statement

Reductions [ NoCranutarity ;

Chosen i

Show Parallel I/0: Yes No i

Current Routine: y_solve

7 Falsely serial loops (with I/0 or MP statements):

_: BT:II/I/280: do i-l.t_last. 1

error_notre:6/1/131: do C_P m-l,S, 1

_' rhs norm:6111121: do C/_P m-l,S, 1

ver_fy 4/1/282: do _-1.571

verifyS/1/299: do m-1.5, i

! [y__olve:8II/302: do k-l, gr_.d_po_ts(3)-2, l
I ,
i i y_solve 13/1/353 do k-l, grid.point(3)-2. I

i

Why...., Update Directives,., ) setting...)

UM:r LOOp: Dismiss ) Help... •

Figure T5-6: The Directives Browser window for the Falsely Serial and I/0 Statement type.

In order to improve the performance, we can enforce a parallel type for the two K loops with an

assumption that the MP calls are thread-safe. This is possible within the context of MP1-2. To

define a new loop type, click the _-e-w Typ_ button in the WhyDirectives window (Figure T5-

7). Select nev" type@ and push [Appl_. A new entry is nov,, added to file userloop.par.
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Selectthe second K loop:y_soive:13/i/353: do k=', grid., and clickthe New T,vp_

button. Again in the LoopType window Choose new t}pe _ and push _-_. CAPO will

save the new entry to file user!oop, par and re-perform the directives analysis with the new
loop types.

Loop: y__ol_e:8/1/302: do k-l,_'id_ ¢'i Itouon: with I/0 or NP statements inside

Type: Falsely Serial New Type...,) Antl-dep. variables Output-dep. vm'lables In/out--dep. vlriables

Hints: --; -.li I i

"] 0,,,_-_,1 p.,.ml loo_ -"J "J! E_
4 I/0 o,..,_--_ _ido i /t I I!; I/I f ll

_,. <,r-]_. _!..,_I,A,_ / ..... iL__
Select All )

Reset _ i_,_rr,-_e...

tO/Exit statements: Contains parallel loops:

i 304:ca1.1303:c'11CAIP_I_CcM,_REC' "-'_[ y_.ol..:10/3/306: do i-l. gTid p,

E324:c=dj. C__SI_i i

i

Loop: _ i 1/302: do k-l, _'id poin_ (3) -2,1 ,

Current Type: I/O inside

New Type:

Ip_,,., s._,.,_,edoctionl,r.._;Or,,ioa,j
To update directives with new loop types,

use-->

Apply } Dismiss.) Help... )

Figure T5-7: The WhyDirectives window for the selected loop and the LoopType window for defining a
new loop type.

11. Insert OpenMP directives. In the File menu, click Save OpenMP Directives Code. Enter a

filename (bt_cap_j_omp.f) and click _-'_. By now you will have the first version of a hybrid BT

code. The log file, bt_ap__j_omp.log, contains additional information and statistics for the

parallelization process. You will see warnings on "1/0 or MP statements inside parallel region".
This is what we need to fix next.

Modification to the generated hybrid code:

12. Replace MP calls with thread-safe version. As mentioned before, the current tool does

not really support the generation of hybrid codes, but is merely used to assist such a process.

The message-passing (MP) calls (CAP_SEND, CAP_RECEIVE...) placed inside the generated

code by the tool are assumed to be used in a single-threaded environment. The supporting

library, CAPLTB, is designed to run under a single-threaded environment as well. So in order to

have the hybrid code working properly, we need to modify' the message-passing calls inside
parallel regions so that they can work safely under a multi-threaded environment To achieve

the goal, we will create a subset of the routines in CAPLTB to support mtdtn-threading. These

routines contain an additional field "TAG" in the argument for use with a specific thread. A
sample implementation of the thread-safe MP routines tused in this tutorial is included in file
capl ib_thread. F.

So we want to make a final touch to the generated code: replace several message-passing calls

with the thread-safe version. Edit file bt_cap__j_omp.f with a text editor:

l) In subroutine Y_SOLVE, include the following two lines in the declaration
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integer omp_get_thread_num, myid

external omp_get_thread_num

2) In subroutine Y_SOLVE, the third parallel region, change

!$OMP PARALLEL DO DEFAULT (SHARED) PRIVATE (i, j, k)

to

!$OMP PARALLEL DEFAULT(SHARED) PRIVATE (i, j ,k,myid)

and add the following linesbefore "do k=l, grid_points (3 )-2, i"

myid = omp_get_thread_num ()

!$OMP DO

Now add a message tag to the four MP statements in the K loop by replacing

CALL CAP_RECEIVE (...)

with

CALL CAP_RECEIVE_TAG ( .... 2000+myid)

and

CALL CAP_SEND(...)

with

CALL CAP_SEND_TAG ( .... 2000+myid)

The tagged SEND and RECEIVE callsare from caplib_thread. F and the tag "2000+myid" is

added to ensure the point-to-point communication between two threads with the same thread

number. The offset "2000" in the tag is to avoid potential conflict with message tags internally

used by CAPLIB, but the choice of the value is a bit of arbitrary.

Lastly, change

!$OMP END PARALLEL DO

to

!$OMP END DO NOWAIT

!$OMP END PARALLEL

3) Apply the same changes as in 2) to the fifth parallel region in subroutine Y_SOLVE and save
the modification.

Compile and run the hybrid code.

In order to compile and run the hybrid code successfully, the following additions or installations are

required:

1) The CAPLIB library from the CAPTools distribution. CAPLIB can be downloaded from

ht .t-p://ca ptools.gre.ac.uk/.

2) A thread-safe extension to some of' the routines in CAPLIB, which are supplied here in

caplib_thread. F for MPI. One of the main things in the file is a dummy MPI_INIT()

routine which just passes the call to MPI_INIT_THREAD ( ). The CAP * TAG routines are also
in this file.

3) A thread-safe implementation of MPI-2 library that supports MPI_INIT_THREAD in level

MPI_THREAD_MULTIPLE. Such an implementation is available from 5Gl's MIPSpro 7.3

compilers and MPT 1.4 toolkit.

We will use the supplied Makefile to compile the hybrid code on the SGI Origin2000. Modify the

content of Makefile, in particular the value for CAPLIB. Then do
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% make

which will create an executable "bt_cap_j_omp. I" To execute the parallel code with 3 MPI processes

and 3 threads per MPI process, do

% setenv OMP NUM_THREADS 3

% mpirun -np 3 ./bt cap_j_omp.l -top pipe3

The output (for a class-W problem on 195MHz O2K) looks like:

Thread support on Rank 0 = 3, number of threads = 3

Thread support on Rank 1 = 3, number of threads = 3

Thread support on Rank 2 = 3, number of threads = 3

PID HOSTNAME MPI_PROCNAME UNIX_PID BIN_NAME

1 turing turing 35973 bt_cap_j_omp.l

2 turing turing 35974 bt_cap_j_omp.l

3 turing turing 35979 bt cap_j_omp.l

Programming Baseline for NPB - BT Benchmark

Size: 24x 24x 24

Iterations: 200 dr: 0.000800

Time step 1

. . ,

5 0.I018045837718E÷02 0.I018045837718E+02 0.4575047075825E-12

Verification Successful

BT Benchmark Completed.

Class = W

Size = 24x 24x 24

Iterations = 200

Time in seconds = 11.66

Mop/s total = 662.12

The execution time from a single process run is 84.69 seconds, so we have a speedup of 7.3 on 9 CPUs.

You can run the code with different combinations of MPI processes and OpenMP threads, for example,

to run with 2 MPI processes and 8 threads per MPI (2x8 = 16 CPUs):

% setenv OMP_NUM_THREADS 8

% mpirun -np 2 ./bt_cap_j_omp.l -top pipe2

Table TS-1 on next page contains a collection of results from runs on two SGI Origin2000s: 195 (CPU

type 195 MHz, 32Kb L1 and 4Mb I_2 cache) and 300 (CPU type 300 MI--Iz, 32Kb L1 and 8Mb L2 cache).

NP stands for number of MPI processes and NT is the number of threads per MPI process. For a given

number of CPUs, the hybrid code has a better performance when NP is close to NT. However, you also

notice that "8x2" performs better than "4x4" or to say MPI is more preferable in this case.
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Table T5-1: Execution time (in seconds) and Mop/s (million floating point operations per second) of the
hybrid BT code, obtained for the Class W (24x24x24) and with 1, 9 or 16 CPUs.

195 MHz Origin2000, 1 or 9 CPUs

NPxNT lx9 3x3 9xl lxl

Time 14.26 11.66 12.26 84.69

Mop/s 541.46 662.12 629.47 91.14

300 MHz Origin2000, 16 CPUs

NPxNT lx16 2x8 4x4 8x2 16xl

Time 8.21 6.38 5.76 5.38 6.88

940.61 1210.05 1339.76 i433.53 1122.38Mop/s
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